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Chapter 1

I nt ro d uc ti o n
Math Xpander is an interactive tool for exploring various topics in high
school mathematics (in particular, graphing and geometry). Students
can explore topics at their own pace, following their own paths of
exploration.
Each exploration is automatically recorded in a workbook so that
students can return to it at any time. They might, for example, want to
repeat a particular exploration, or use one exploration as the starting
point for another exploration.
Teachers can use Math Xpander to devise illustrative mathematical
experiments which their students can recreate in the classroom.
Teachers can also take advantage of built-in teaching aids, such as a
catalog of common relations: linear, quadratic, exponential, etc. These
relations can be easily customized and plotted, helping students to learn
how to identify the type of relation that generates a particular graphical
form.
Math Xpander has been designed for handheld devices running the
Microsoft® Windows® CE operating system.

e-Lessons
A companion product is a Math Xpander e-Lesson. An
e-Lesson is a self-paced tutorial covering one or more
important mathematical concepts. It can also be used
by teachers to demonstrate a particular mathematical
concept or problem.
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Math Xpander Components
Math Xpander has five components. These are:
n

scientific calculator
You can use Math Xpander as you would any other scientific
calculator. You can, for example, make algebraic, trigonometric,
relational, probability, and calculus calculations (see chapter 3).

n Table Xpander

Table Xpander enables you to create and statistically analyze
samples of data.
Table Xpander is discussed in chapter 4.
n Graph Xpander

You plot graphs using Graph Xpander. You can transform a graph
and watch the equation for the graph continuously update. You can
also add various objects to the viewing window, display
measurements, and make calculations based on those
measurements.
Graph Xpander is discussed in chapter 5.
n Geometry Xpander

Geometry Xpander enables you to create various geometric
objects—such as points, segments, rays, lines, and circles—
transform these objects, set various constraints, take
measurements, and make calculations based on the attributes of
objects.
Geometry Xpander is discussed in chapter 6.
n Note Recorder

You can use two on-screen keyboards to type notes. Your notes
could be reminders, lists of books to read, homework topics, and so
on.
Notes are discussed on page 16.
Every operation you undertake, regardless of the component used, is
recorded in a workbook. A workbook is like a diary of your calculations
and explorations. You can go back to an entry in that diary—for example,
a graph you plotted, a geometric object you constructed, or a table of
data you analyzed—and repeat that exploration. The notes you enter are
also recorded in a workbook.
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Launching Math Xpander
When Math Xpander is launched initially, a blank
workbook is displayed.
The workbook window keeps a record of all the
explorations and calculations you’ve undertaken
while this particular workbook was open. Up to 9
items can be displayed at one time. You can scroll
vertically to display further explorations, and
horizontally to reveal more of a particular
exploration.
See “Workbooks and Notes” on page 7 for further
information.

Figure 1-1: A blank workbook.

Input and Selection
Stylus
The stylus is the principal tool for entering information, making
selections, and drawing and manipulating objects.
You enter information—such as mathematical expressions, notes, and
workbook names—by using the stylus to tap on characters from onscreen keyboards. Similarly, you select an option—a menu item, an OK
button, a check box, and so on—by tapping on it with the stylus.
Information that can be edited or copied—such as a mathematical
expression, the result of a calculation, a name of a file, and so on—can be
selected using the stylus. In some cases you can just tap once on the
information to select it—a workbook item, for example—while in other
cases you must drag the stylus over the characters you want to select.
You will also need the stylus to draw objects in Math Xpander—such as
points, segments, and circles—and to manipulate them.

Keyboards
For most input, you will make use of two on-screen keyboards:
n

math keyboard, and

n

standard keyboard.

Launching Math Xpander
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The math keyboard has numerous palettes of mathematical functions
and operators. You choose a function or operator by displaying the
appropriate palette and tapping on the button that represents that
function or operator. The math keyboard is described in detail in
chapter 3.
The standard keyboard contains the QWERTY characters you find on a
standard PC keyboard. You use the standard keyboard to enter text and
to give names to the variables and files that you create.
n

To display the currently selected keyboard, tap on the keyboard
icon.
The keyboard icon is

if the standard keyboard is selected, or

if the math keyboard is selected.
n

To hide the keyboard, tap on the keyboard icon.

n

To select a keyboard, tap on

.

The keyboard list is displayed.
Select either Math Keyboard or Standard Keyboard.
The selected keyboard is displayed.

Menus
You use the stylus to display and select menu options.

Math Xpander online help
To display online help, select Help from the Start menu. If a dialog box is
open at the time, the online help displayed provides information about
that box; otherwise a list of online help topics relevant to the
environment in which you are working is displayed. For example, if you
select Help from the Start menu when the graph window is open, a list of
help topics relevant to graphing is displayed.
You can display a complete list of Math Xpander help topics by selecting
Contents from the Help menu when a workbook is open. This list covers
all the Math Xpander environments: workbooks, notes, tables, math,
graphing, and geometry.
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Chapter 2

Wo rk bo ok s an d No tes
A workbook is the hub of your Math Xpander activities. You perform
calculations from a workbook, and it is from a workbook that you access
the other components that make up Math Xpander: tables, graphing,
geometry, and note recording.
Everything you do with Math Xpander—all your graphic, geometric, and
tabular explorations, your notes, and all your calculations—are recorded
sequentially in a workbook. You can always go back to a previous
activity and repeat it. You can also copy a previous calculation to a new
line in the workbook.
You can create any number of workbooks. You could, for example, create
one workbook for classwork, one workbook for homework, and another
for a class project.
Only one workbook can be open at a time.

The Workbook Window
When you open Math Xpander, a workbook window is displayed.
When Math Xpander is opened for the first time,
the workbook window is blank (as in Figure 2-1).
A blank workbook window is also displayed:
n

when you create a new workbook, or

n

when you return to Math Xpander after
exiting a workbook (that is, after selecting
Exit from the File menu).

In other cases, you can return to Math Xpander
and find the workbook window is as it was when
you left it, with all your explorations and
calculations still listed.

Figure 2-1: Blank workbook

The workbook window displays all the explorations and calculations
you’ve undertaken while this particular workbook was open (see
Figure 2-2 below). Up to 9 items can be displayed in the workbook
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history at one time. You can scroll vertically to display further
explorations, and horizontally to reveal more of a particular exploration.

Input line
The input line is the next free line on the workbook window (see
Figure 2-2 below). It is where you can enter calculations.
To enter a calculation, the input line must be active (that is, the cursor
must be on the line). To make the input line active:
n

tap on the

n

tap on the input line.

button, or

To record what you enter on the input line, tap on ENTER on the math
keyboard (see page 20). To cancel an entry, thereby preventing it from
being recorded, tap on ESC.

workbook history

input line

workbook tool bar
workbook menu bar

Figure 2-2: Workbook window with items
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Workbook menu map
New
File

Open...
Save as...

Graph

Create
Exit

Table
Construction
Note

Edit

Copy
Paste
Duplicate
Delete
Preferences...

Tools

Numeric Root...

Help

Contents...
About...

Figure 2-3: Workbook menu map

Workbook tool bar buttons
The workbook window tool bar buttons provide you with workbook
tools and with access to Math Xpander’s components.
Button

Name

Description

Input line

Moves the cursor to the input line.

Graph

Opens Graph Xpander.

Table

Opens Table Xpander.

Geometry

Opens Geometry Xpander.

Note Recorder

Opens the Note Recorder.

Help

Opens online help.
Table 2-1: Workbook window tool bar buttons

The Workbook Window
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Workbook items
Graph, geometry, and table workbook items are labeled and show a
summary of the exploration. The label uniquely identifies each
workbook item: Graph1, Graph2, Graph3, and so on. Notes are also
labeled. The entire contents of a note appears in the workbook.
Horizontal lines separate each item.
You can add a comment to a workbook item (see “Adding a comment to
workbook item” on page 12). The comment is displayed to the right of
the workbook item label. You can later edit the comment.

Returning to a previous exploration
You can return to a previous exploration by selecting it from the
workbook history. You might want to review an exploration, or use it as
the starting point for another exploration. The original workbook item
cannot be modified, unless it is the last item in the workbook.
To return to a previous exploration:
1. Tap on the label of the workbook item you
want to re-explore.
A label menu is displayed.
2. Select Explore to open the workbook item,
or, in the case of a note, select Edit.
Note that only table, graph, geometry, and
note items can be re-explored in this way.
To repeat a calculation, you need to copy it
to the input line (as explained in the next
section).

Figure 2-4: Workbook label
menu

Selecting a previous expression or result
To select an expression or result in history, tap once on it. The
expression or result is highlighted to indicate that it is selected.
To select a subexpression or part of a result:
1. Tap once on the expression or result that contains the character(s)
you want to select.
The expression or result is highlighted to indicate it is selected.
2. Drag the stylus across the character(s) you want to select.
The character(s) are highlighted to indicate that they are selected.
The remaining characters are no longer highlighted.
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Duplicating a previous expression or result
Once you have selected a previous calculation, subexpression, result, or
subresult, you can copy your selection straight to the input line using
the Duplicate function:
1. Select the expression, subexpression, result, or subresult.
2. Open the Edit menu.
3. Select Duplicate.
The expression, subexpression, result, or subresult you selected is
copied to the input line.

Reusing the result of the last calculation
You can copy the result of the last calculation straight to the input line.
Make sure nothing is selected and:
1. Open the Edit menu.
2. Select Duplicate.
The result of the last calculation is copied to the input line.

Copying a previous expression or result
Once you have selected a previous calculation, subexpression, result, or
subresult, you can copy your selection and paste it on the input line:
1. Select the expression, subexpression, result, or subresult that you
want to copy (as explained above).
2. Open the Edit menu.
3. Select Copy.
4. Make the input line active (see “Input line” on page 8).
5. Open the Edit menu.
6. Select Paste.
The characters you copied are pasted on the input line.
This procedure is useful if you want to repeat a calculation with greater
precision (as explained in chapter 3).

The Workbook Window
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Deleting workbook items
You can only delete the last workbook item.
1. Tap on the label of the workbook item.
The label menu is displayed (see Figure 2-4 above).
2. Tap on Select All.
3. Open the Edit menu.
4. Select Delete.
If you are deleting a calculation, the calculation is immediately
deleted and you can ignore the rest of this procedure.
5. If you are deleting an item other than a calculation, a warning
message is displayed asking you to confirm that you want to delete
the workbook item. Tap on Yes.
The workbook item is deleted.
You cannot undo the deletion of an item.
You can also delete a calculation. Tap in the space in front of the
result of the calculation, and then tap on Select All from the popup label menu. Then follow the above procedure from step 3.

Adding a comment to workbook item
1. Tap on the label of the item that you want
to add a comment to.
The label menu is displayed (see
Figure 2-4).
2. Tap on Edit Comment.
3. Type the comment using keys from the
standard keyboard (see “Keyboards” on
page 5 for further information).
The comment is displayed to the right of
the workbook item label.
You can later edit the comment by repeating the
above procedure.
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Figure 2-5: Comment
added to an item
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Setting Preferences
By default, Math Xpander interprets angle measurements in radians and
displays numbers only to four significant digits. These default
preferences are shown as the first item in every workbook. You cannot
delete this item from the workbook history.

You can change these preferences at any time. A record of the change is
automatically added to the workbook history and subsequent
calculations and explorations use these new preferences.
To change workbook preferences:
1. Open the Edit menu.
2. Select Preferences…
The Preferences dialog box is displayed.
3. If required, change the unit of angle
measure:
a. Tap on the Angular Units arrow to display
the list of options.
b. Select a unit of angle measure. You have
the choice of radians or degrees.
4. If required, change the numeric display
precision. You do this by tapping in the
Display Precision box and:

Figure 2-6: Preferences
dialog box

• tapping on the Display Precision arrows, or
• entering numbers from the hard keyboard.
You can enter a number between 1 and 12. This number determines
how many digits are displayed in floating-point numbers.
5. Tap on OK.
Note that you can set the angular units setting in Geometry Xpander, but
this setting applies only to geometry.

Setting Preferences
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Workbook Management
You can create any number of workbooks, although only one can be
open at a time. A workbook file always has the extension .mwb.

Creating a workbook
To create a new workbook:
1. Open the File menu.
2. Select New.
A message is displayed asking if you want to save your current
workbook.
3. You can create a new workbook without saving changes, or save
the changes to the workbook.
• If you want to save the current workbook, tap on Yes.
If you have previously saved the current workbook, it is saved
again and a new blank workbook is displayed.
If the current workbook has not been previously saved, you
must now give it a name and specify a location for it. See “Saving
a workbook” on page 14 for further information.
• If you don’t want to save the workbook, tap on No.
Any changes you made to the current workbook are discarded,
and a new blank workbook is displayed.
4. If you want to cancel the process and return to the current
workbook, tap on Cancel.

Saving a workbook
You can save a workbook using a different name and, if required, to a
different file location.
1. Open the File menu.
2. Select Save As…
The Save As dialog box is displayed.
3. If you want to save your workbook in some other folder, open that
folder.
4. Tap in the Name box.
14
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5. Display the standard keyboard (see “Keyboards” on page 5).
6. Enter a name for the workbook.
7. Tap on OK.
The workbook is saved in the specified location.
Note that the Type box contains default settings. Do not change
these settings.

Opening a workbook
1. Open the File menu.
2. Select Open…
The Open dialog box is displayed.
3. If the workbook you want to open is in another folder, open that
folder.
4. In the Type box, select Workbooks (*.mwb).
Workbooks are listed by name.
5. Double-tap on the workbook you want to open.

Exiting a workbook
When you exit a workbook, you also close Math Xpander.
1. Open the File menu.
2. Select Exit.
A message is displayed asking if you want to save your current
workbook.
3. To save the workbook, tap on Yes.
• If you have previously saved the current workbook, the
workbook is saved and Math Xpander closes.
• If the current workbook has not been previously saved, you must
now give it a name and specify a location for it. See “Saving a
workbook” on page 14 for further information. After saving the
workbook, Math Xpander closes.
4. To exit without saving the workbook, tap on No.

Workbook Management
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Notes
You can use the Note Recorder to enter a description, comment, or
annotation regarding a particular exploration. You could also record a
note to describe the contents of the entire workbook.

Creating a note
1. With a workbook open:
• tap on the Note Recorder button on the
tool bar:

, or

• open the File menu, select Create, and
then select Note.
The Notes dialog box is displayed.
2. Open the standard keyboard (see
“Keyboards” on page 5).
3. In the Heading box, enter a heading for the
note.

Figure 2-7: Recording notes

4. In the Notes box, enter your note.
5. Tap on OK.
The note is added to the workbook history.

Editing a note
1. Tap on the label of the note in the
workbook history. The note label menu is
displayed.
2. To edit just the heading of the note, select
Edit Comment from the note label menu and
go to step 4.
3. To edit the body of the note, select Edit
from the note label menu.
The Notes dialog box is displayed, showing
the note’s contents.
4. Open the standard keyboard (see
“Keyboards” on page 5).

Figure 2-8: Note label menu

5. Make your changes.
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6. If you are editing the Notes dialog box, tap on OK to save your
changes; otherwise tap elsewhere to complete the changes to the
note heading.

Notes
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Chapter 3

Math
Math Xpander provides you with tools for performing many types of
calculations. Use the special on-screen math keyboard for calculations.
The math keyboard can also be used to:
n

construct expressions

n

assign values to variables, and

n

define functions.

There is also a special tool to help you find the root(s) of an equation.
To perform calculations, you need to have a workbook window displayed
(see “The Workbook Window” on page 7).

Math Keyboard
The on-screen math keyboard provides access to a wide range of
mathematical operators and functions that you can use to construct
expressions.

To display the math keyboard
Tap on the keyboard button on the task bar. The appearance of this
button is determined by what keyboard is currently selected:
if the standard keyboard is selected, or
selected.

if the math keyboard is

If the standard keyboard is displayed instead of the math keyboard:
1. tap on the keyboard switch on the task bar—
2. select Math Keyboard from the keyboard list.

To hide the math keyboard
Tap on the keyboard button on the task bar.
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—and

Math keyboard functions and operators
The math keyboard comprises three groups of keypads; a left keypad
group, a center keypad group, and a right keypad group. Within each
keypad group you can display various palettes of symbols, functions,
and operators.
LEFT KEYPAD
Palettes:
numeric
variables

RIGHT KEYPAD

CENTER KEYPAD
Palettes:

Palette:

main menu
algebra

commands

trigonometric
test
number
advanced
edit
Figure 3-1: Math keyboard groupings

When the math keyboard is displayed for the first time, the numeric and
algebra palettes are displayed. If you hide the math keyboard, and then
display it again, you will find it as it was when you left it. For example,
suppose you displayed the math keyboard and selected functions and
operators from the trigonometric and variables palettes to construct an
expression. You then hid the math keyboard. When you display the math
keyboard again, the trigonometric and variables palettes are displayed.

Left keypad group
The left keypad group displays one of two palettes:
n

numeric palette, containing numerals and arithmetic operators

n

variables palette, containing commonly used variable names, and
operators to create variables and define functions.

numeric

variables

Figure 3-2: Left keypad palettes
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When the numeric palette is displayed, tap on
variables palette.
When the variables palette is displayed, tap on
numeric palette.

to display the
to display the

Center keypad group
The center keypad group contains five palettes of mathematical
functions and one palette of edit and navigation commands.
The palettes of functions are:
n

algebra

n

trigonometric

n

test

n

number

n

advanced

Figure 3-3 shows the functions that can be selected from each palette.

algebra

trigonometric

test

number

advanced

edit

Figure 3-3: Center keypad palettes

To display the center keypad group’s main menu, tap on
on any
function palette. Tap on a menu option to display the corresponding
palette.

Math Keyboard
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For example, to display the trigonometric
palette:
1. Tap on
to display the center keypad
group’s main menu.
The center keypad group’s main menu is
displayed (see Figure 3-4).
2. Tap on Trig.
The trigonometric palette is displayed.
3. To select a trigonometric function, tap on
the corresponding button.

Figure 3-4: Center keypad
group’s main menu

A complete list of functions—including syntax
and examples—can be found in Appendix E.

Right keypad group
The right keypad group does not contain further palettes. It contains
buttons for the commonly used commands: ESC, ïDEL, and ENTER.

Special constants
In addition to mathematical functions and operators, the on-screen
keyboards give you access to the special constants π and e.
Constant

Select from…

Approximation used

π

trigonometric palette of math
keyboard.

e

standard keyboard (standard lower- 2.71828182845905
case letter). See “Keyboards” on
page 5 for instructions on accessing
the standard keyboard.

3.14159265358979

Table 3-1: Special constants
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Calculations using the Math Keyboard
You can perform calculations by constructing expressions using the
symbols, functions, and operators on the various palettes of the
on-screen keyboards. Numbers and basic arithmetic operators can also
be entered from the hard keyboard.
You construct an expression in the same left-to-right order that you use
when writing out an expression on paper.
In some cases you need to explicitly indicate an operator’s scope. For
example, to enter 103 + 4 rather than 103 + 4, you need to indicate that the
addition is to apply to the entire entry rather than just to the exponent.
You indicate this by tapping the right arrow key of the math keyboard
after entering the exponent. Similarly, to indicate that you want to
calculate 5 + 2 rather than 5 + 2 , you must tap on à after entering 5.
Five sample calculations are provided over the next few pages. The first
example illustrates how to construct basic mathematical expressions.
The second example illustrates how you can construct an expression by
taking building blocks from more than one palette of the math keyboard.
It also illustrates the use of the standard keyboard in constructing
expressions containing e.
Examples three and four illustrate the general method for specifying
functions that take more than one argument.
The final example illustrates how to use an expression from an earlier
workbook item as a building block in creating a new expression.
Each example illustrates how the right arrow key can be used to ensure
that operators are applied to their correct operands. Note that in many
cases, you can use the stylus to position the cursor instead of the right
arrow key. Using the stylus may be easier in cases where you would need
to tap on à twice to correctly position the cursor for the next entry (as
in example 2 below).
The results in examples 1, 2, and 4 are approximations based on the
default numeric display precision of 4. To get the most precise answer
possible, you should set the numeric display precision to 12. See “Setting
Preferences” on page 13 for instructions on changing the numeric
display precision.

Calculations using the Math Keyboard
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Example 1
3

To enter and evaluate

2

6 –7 :

1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. Enter the expression by:
a. tapping on

x

b. tapping on 6
c. tapping on xy
d. tapping on 3
e. tapping on à or tapping to the immediate right of the last entry
f. tapping on –
g. tapping on 7
h. tapping on x2
4. Evaluate the expression by tapping
on ENTER.
The result, 12.92, is displayed on
the line below the expression. This
result assumes a numeric display
precision of 4.

Figure 3-5: Sample expression and result

Example 2
To enter and evaluate sin(3π/4)–log(e):
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. Display the trigonometric palette (see “Math keyboard functions
and operators” on page 20).
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4. Enter the expression by:
a. tapping on sin
b. tapping on 3
c. tapping on x (multiplication sign, not the variable x)
d. tapping on π
e. tapping on /
f. tapping on 4
g. tapping on à or tapping to the immediate right of the last entry
h. tapping on –
i. displaying the algebra palette
j. tapping on log
k. displaying the standard keyboard (see “Keyboards” on page 5),
and
l. tapping on e
5. Evaluate the expression by tapping
on ENTER.
The result, 0.2728, is displayed on
the line below the expression.

Figure 3-6: Sample expression and result

This result assumes a numeric display precision of 4 and that the
mode is set to radians.

Calculations using the Math Keyboard
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Example 3
To calculate the greatest common divisor of 124 and 32:
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. Display the number palette (see “Math keyboard functions and
operators” on page 20).
4. Enter the expression by:
a. tapping on gcd
b. tapping on 1
c. tapping on 2
d. tapping on 4
e. tapping on à or tapping to the immediate right of the comma
f. tapping on 3
g. tapping on 2
5. Evaluate the expression by tapping
ENTER.
The result, 4, is displayed on the line
below the expression.

26

Figure 3-7: Sample expression and result
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Example 4
To integrate 3x4 with respect to x over the range 1–5:
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. Display the advanced palette (see “Math keyboard functions and
operators” on page 20).
4. Enter the expression by:
a. tapping on òdx
b. tapping on 1
c. tapping on à or tapping on the upper limit
d. tapping on 5
e. tapping on à or tapping on the integrand
f. tapping on 3
g. tapping on x (the multiplication sign, not the variable x)
h. tapping on x (the variable x, not the multiplication sign)
i. displaying the algebra palette
j. tapping on xy
k. tapping on 4
l. tapping on à or tapping on the right of the “d”
m. tapping on x (the variable x, not the multiplication sign).
5. Evaluate the expression by tapping
on ENTER.
The result, 1874, is displayed on the
line below the expression.
This result assumes a numeric
display precision of 4.

Calculations using the Math Keyboard

Figure 3-8: Sample expression and result
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Example 5
To differentiate cos(2·x) with respect to x:
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. Display the advanced palette (see “Math keyboard functions and
operators” on page 20).
4. Enter the expression by:
a. tapping on d/dx
b. tapping on x (the variable x, not the multiplication sign)
c. tapping between the parentheses
d. displaying the trigonometric palette
e. tapping on cos
f. displaying the numeric palette
g. tapping on 2
h. tapping on x (the multiplication sign, not the variable x)
i. displaying the variable palette
j. tapping on x (the variable x, not the multiplication sign).
5. Evaluate the expression by tapping
on ENTER.
The result is displayed on the line
below the expression.
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Figure 3-9: Sample expression and result
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Example 6
You can use copy and paste tools to reuse a previous expression or
result.
2

Suppose the expression, x + 2 ⋅ x + 1 appears in history—as in
Figure 3-10—and you want to modify it by applying the sine function to
the subexpression, 2 ⋅ x .
2

1. Select the expression, x + 2 ⋅ x + 1 from
history. See “Copying a previous
expression or result” on page 11 for
instructions on selecting entries in the
workbook.
2. Open the Edit menu.
3. Select Copy.
4. Tap on

.

The cursor is displayed on the input line.
5. Open the Edit menu.

Figure 3-10: Item selected from
history

6. Select Paste.
The expression is pasted on the input line.
Any selected character or sequence of
characters on the input line is replaced
when you paste to the input line.

Figure 3-11: Item copied to
input line

Calculations using the Math Keyboard
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7. Drag the stylus across 2 ⋅ x to highlight the
subexpression (as in Figure 3-12).
8. Display the math keyboard (see “To
display the math keyboard” on page 19).
9. Display the trigonometric palette (see
“Center keypad group” on page 21).

Figure 3-12: Selected a
subexpression

10. Select sin.
The expression becomes
2

x + sin ( 2 ⋅ x ) + 1 . Note that parentheses
are inserted automatically.

Figure 3-13: Function applied to a
subexpression

The copy-and-paste technique illustrated in example 5 above is
useful if you want to repeat a calculation at a higher numeric
display precision (that is, to obtain a more precise answer).
After increasing the numeric display precision, select the earlier
expression or result, and select Duplicate from the Edit menu to
copy it to the input line, and tap on ENTER.
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Clearing the contents of the input line
You can clear the contents of the input line by selecting the contents on
the input line and tapping on ïDEL in the right keypad group in the
math keyboard.

Parentheses
Math Xpander automatically inserts parentheses to enclose arguments
for functions, such as cos(45). If a function requires more than one
argument, a comma is displayed inside the parentheses. The cursor is
located in the first argument position. Enter the first argument, tap on à
or to the right of the comma, and enter the second argument.
Parentheses are important in specifying the order of operation. Without
parentheses, Math Xpander calculates according to the order of
algebraic precedence (see “Order of operation” on 31).

Order of operation
Functions and operators within an expression are evaluated in the
following order. Functions and operators with the same precedence are
evaluated in order from left to right (with the exception of consecutive
powers, which are evaluated from right to left).
1. Expressions in parentheses (from inner to outer).
2. Prefix functions (for example, sin, ln) and functions where the
arguments are graphically enclosed: square root, nth root, division,
absolute value, integral, etc.
3. The factorial operator:!
4. Power
5. Unary – (negation), unary +
6. Multiplication
7. Binary + and –
8. =, ≠, <, >, ≤, ≥
9. not
10. and
11. or
12. »(definition of variable)
13. := (definition of function)

Calculations using the Math Keyboard
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Scientific notation
If the result of a calculation is too small or too large to be accurately
displayed using the currently set numeric display precision, the number
is displayed in scientific notation. For example, if the numeric display
precision is 4, the result of calculating 56 is displayed as 1.563E+004
(which is equivalent to1.563 × 104).
You can enter very large or very small numbers using the EEX operator.
This operator can be selected from the numeric palette of the math
keyboard (see page 20).

Example
To calculate (5 × 1016 ) × (8 × 1026 ):
1. Display the math keyboard (see “To display the math keyboard” on
page 19).
2. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
3. Enter the expression by:
a. tapping on 5
b. tapping on EEX
c. tapping on 1
d. tapping on 6
e. tapping on x (the multiplication sign, not the variable x)
f. tapping on 8
g. tapping on EEX
h. tapping on 2
i. tapping on 6
4. Evaluate the expression by tapping on
ENTER.
The result, 4E+043 (that is 4 × 1043 ) is
displayed under the expression.

32

Figure 3-14: Sample expression and
result
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Largest and smallest numbers
The largest number Math Xpander can represent is 1.79769313486E+308.
Any larger result is displayed as Overflow. The smallest positive
number Math Xpander can represent is 2.22507385851E–308. Any smaller
result is displayed as zero.

Explicit multiplication
All multiplication must be explicit. You must enter a multiplication sign
in an expression where multiplication is to occur. For example, 2x must
be entered as 2 × x. It is displayed as 2 ⋅ x .

Assigning a Value or Expression to a
Variable
You can create your own variables and assign a real number or
expression to each one.
You give a variable a name. The name can consist of:
n

a single alphabetical character other than e or π, or

n

a string of alphanumeric characters that begins with an
alphabetical character.

Variable names are case-sensitive.
In general, the process to assign a value or expression to a variable is to
specify the value or expression, select the sto command from the math
keyboard, specify a name for the variable, and tap on ENTER.

Example
3

To assign the value of the expression 5 – 2 to the variable named a:
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Display the math keyboard (see “To display the math keyboard” on
page 19).

Assigning a Value or Expression to a Variable
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3. Enter the expression by:
a. tapping on 5
b. tapping on –
c. tapping on 2
d. tapping on xy
e. tapping on 3
f. tapping on à or tapping to the immediate right of the last entry
4. Open the variables palette (see “Left keypad group” on page 20).
5. Tap on sto
6. Specify the name for the variable by tapping on a
7. Tap on ENTER.
The result of the evaluated
expression, –3, is stored in the
variable named a.

Figure 3-15: Assigning an expression to
the variable named a.

In this example, the name for the variable was chosen from the variables
palette. However, you are not restricted to the variables on the variables
palette in naming your variables. You can, for example, use the standard
keyboard to give your variable any name you choose (as long as it begins
with an alphabetical character); for example, length or slope.
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Recalling a variable
You recall the number or expression assigned to a variable by entering
the variable’s name.

Example
This example recalls the variable, a, used in the example above to
evaluate the expression 4a × 2 .
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. If the math keyboard is not already open, open it (see “To display
the math keyboard” on page 19).
3. If the variable palette is not displayed, tap on

.

If you had named your variable using characters only available
from the standard keyboard, you would have to open the standard
keyboard at this step, not the variables palette of the math
keyboard.
4. Enter the expression by:
a. tapping on 4
b. tapping on x (the multiplication sign, not the variable x)
c. tapping on a
d. tapping on x (the multiplication sign, not the variable x)
e. tapping on 2
5. Tap on ENTER.
Because –3 had been assigned to a
(see previous section), the
expression 4a × 2 evaluates to –24.

Assigning a Value or Expression to a Variable

Figure 3-16: Recalling the variable
named a.
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Defining and Evaluating a Function
You can define a function in terms of one, two or three variables. The
syntax to use is:
function name (variable1, variable2, …) := definition
Examples: h(x) := 9x + 7 and m(x, y) := x2 + y2
Once a function is defined, you can evaluate it for a particular value of
the independent variable by specifying that value as the argument of the
function; for example, h(9).

Example
In this example the function, h(x):=9x+7 is first defined and then
evaluated when x = 9.
Define the function
1. Place the cursor on the input line (see page 8).
2. Display the math keyboard (see “To display the math keyboard” on
page 19).
3. If the variable palette is not displayed, tap on

.

4. Specify the function by:
a. tapping on h
b. tapping on (
c. tapping on x (the variable x, not the multiplication sign)
d. tapping on à or tapping to the right of the x
e. tapping on :=
5. Enter the expression by:
a. tapping on 9
b. tapping on x (the multiplication sign, not the variable x)
c. tapping on x (the variable x, not the multiplication sign)
d. tapping on +
e. tapping on 7
6. Define the function by tapping on
ENTER.
Figure 3-17: Define the function

36

Chapter 3: Math

Evaluate the function when x=9
1. If the cursor is not displayed on the input line:
• tap on the

button, or

• tap on the input line.
2. Tap on h
3. Tap on (
4. Tap on 9
5. Evaluate the function by tapping on
ENTER.
The result, 88, is obtained by
substituting 9 for x in the expression
you assigned to the function h(x).

Figure 3-18: Evaluate the function when
x=9

Finding a Numeric Root
Math Xpander provides you with a tool—the numeric root finder—for
finding the numeric value of a variable for which a particular expression
evaluates to zero or an equation is satisfied. The expression or equation
must evaluate to a real number.
The expression or equation may contain more than one variable, in
which case you must not only specify the variable to solve for, but also
have stored values in the other variables.
You can construct your expression or equation in the numeric root
finder, or copy it into the numeric root finder from the workbook history.
The numeric root finder is accessible from a workbook.

Finding a Numeric Root
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To find the numeric root of an expression:
1. Open the Tools menu.
2. Select Numeric Root.
The Numeric Root dialog box is displayed.
3. In the Solve box, enter the expression you
want to solve.
Enter the expression by constructing it
from the various palettes of the math
keyboard.
4. In the For box, enter the variable that you
want to solve for.
Even if your expression is in one variable,
you still need to enter the variable in the
For box.

Figure 3-19: Numeric root
solution near a value

5. To indicate that the root you want to find is near a particular value,
tap on the Search near button and enter the value in the box below
the button.
Typically this value is an estimate of the root based on your
analysis of the graph of the expression.
6. To indicate that the root you want to find
lies between two values:
a. Tap on the Search in range button.
b. Tap in the left box below the buttons
and enter a value for the lower bound of
the search range.
c. Tap in the right box below the buttons
and enter a value for the upper bound
of the search range.
The search range value could be based on
your analysis of the graph of the
expression.

Figure 3-20: Numeric root
solution within a range

7. Tap on Solve.
The result is displayed in the Result box.
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Chapter 4

E x p lo r i n g Tabl e s
Table Xpander is where you can record data and statistically analyze it.

Accessing Table Xpander
You access Table Xpander from a workbook (see “The Workbook
Window” on page 7 for information). Once a workbook is open, you can:
n

tap on the Table button on the toolbar:

n

open the File menu, select Create, then select Table, or

n

tap on a table label in the workbook history and select Explore from
the menu.

, or

If you tap on the Table button or choose Table from the Create submenu,
Table Xpander opens with a blank table; if you tap Explore after tapping
on a table label in history, Table Xpander opens and displays details of
the table associated with that workbook item.
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The Table Window
The table window consists of the table pane, sash, and statistics pane.

Table pane

Sash

Statistics pane

Figure 4-1: Table window

Scrolling vertically. Use the vertical scroll box to scroll through rows of
data.

Scrolling horizontally. Use the horizontal scroll box to scroll through
columns of data.

Table pane
The table pane is where you create a table. You create one table at a
time. If you are beginning a new table exploration, the table pane
displays a three-column table. The first column is headed n and displays
the row numbers. The other two columns are empty and are headed C1
and C2. If you are revisiting a table exploration, the table pane displays
the columns and data of the particular exploration.

Statistics pane
The statistics pane displays statistics based on the data in the table
pane. The statistics are displayed only if you have selected Statistics from
the Table menu (see page 45).
Statistics are automatically updated to reflect changes you make to the
values in the table pane.
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Sash
The sash is the shaded boundary between the table pane and the
statistics pane. The sash enables you to increase or decrease the size of
a pane:
1. Place the stylus on a sash.
2. Drag the stylus up or down.
Dragging the sash up reveals more of the statistics pane; dragging the
sash down reveals more of the table pane.

Table window menu map
Copy
Paste
Edit

Delete
Insert /Append column
Remove
Clear

Table

Statistics...

Figure 4-2: Table window menu map

Table window buttons
Button

Name

Description

Workbook

Returns you to the current
workbook.

Help

Display the contents of the
online help.
Table 4-1: Table window buttons

The Table Window
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Adding Values
You can add an unlimited number of columns, and an unlimited number
of values, to a table.
To add a value:
1. Tap on an empty cell.
The cell is highlighted to indicate it is selected. If the cursor is not
displayed, tap on the cell again.
2. Enter a number or an expression that evaluates to a real number;
for example, 6 or 92 × 63.
3. Repeat steps 1 and 2 to enter further values.

Editing Tables
You can edit a table by:
n

inserting rows and columns

n

appending a column to a table

n

changing the width of a column

n

clearing values in a specified column

n

removing columns and rows

n

changing the value in a cell.

Inserting an empty row
1. Select a row. You can do this by:
• tapping on the row number, or
• dragging the stylus through the entire row.
The row is highlighted to indicate it is selected.
2. Open the Edit menu.
3. Select Insert row.
An empty row is inserted directly above the selected row.

42

Chapter 4: Exploring Tables

Inserting an empty column
You can insert an empty column in a table. The empty column is inserted
to the left of the selected column.
1. Select a column. You can do this by:
• tapping on the column heading, or
• dragging the stylus through the entire column.
The column is highlighted to indicate it is selected.
2. Open the Edit menu.
3. Select Insert column.
An empty column is inserted directly left of the selected column.

Appending an empty column
You can append an empty column to the end of a table. Make sure no
column is selected and:
1. Open the Edit menu.
2. Select Append column.
An empty column is added after the last column in the table.

Changing the width of a column
You can increase or decrease the width of a column.
1. Select the right border of the heading of the column you want to
change the width of.
2. Change the column width by either:
• dragging the stylus to the left to decrease the column width, or
• dragging the stylus to the right to increase the column width.
3. Lift the stylus from the heading.

Editing Tables
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Clearing values in a column
To clear the values in a column:
1. Select the column. You can do this by:
• tapping on the column heading, or
• dragging the stylus through the entire column.
The column is highlighted to indicate it is selected.
2. Open the Edit menu.
3. Select Clear column.
The data is removed and a blank column remains.

Removing a column
To remove a column:.
1. Select the column that you want to remove.
The column is highlighted to indicate that it is selected.
2. Open the Edit menu.
3. Select Remove column.
The column is removed from the table. The numbers of the
remaining columns are adjusted.

Removing a row
To remove a row:
1. Select the row that you want to remove.
The row is highlighted to indicate that it is selected.
2. Open the Edit menu.
3. Select Remove row.
The row is removed from the table. The numbers of the remaining
rows are adjusted.
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Changing the value in a cell
To change a value in a cell:
1. Tap on the cell that contains the value you want to change.
The cell is highlighted to indicate it is selected.
2. Enter a number or expression that evaluates to a real number.
3. Tap in a blank cell or on ENTER.

Calculating Statistics
You can statistically analyze the values in a table. Only one-variable
analysis is possible. The frequency of each value in a column is taken as
1.
The statistics that can be calculated are shown in Table 4-2.
1. Open the Table menu.
2. Select Statistics…
The 1-Var Statistics dialog box is
displayed.
3. Select the one-variable statistics to
calculate by tapping on the
corresponding check boxes.
4. Tap on OK.
The statistics for each column of data are
displayed in the statistics pane.

Calculating Statistics

Figure 4-3: 1-Var Statistics
dialog box
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Statistic

Description

Mean

Mean of values

Population Std
Dev

Population standard deviation

Sample Std Dev

Sample standard deviation

Sample size

Number of values

Sum

Sum of the values

Minimum

Minimum value

1st quartile

Median of the lower half of the values

Median

Median of the values

3rd quartile

Median of the upper half of the values

Maximum

Maximum data value
Table 4-2: One-variable statistics.
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Chapter 5

E x p lo r i n g G r a p hs
Graph Xpander provides an interactive and
dynamic tool for creating, manipulating,
and exploring graphs. It is interactive in
that you can directly transform
certain graphs with the stylus; and it
is dynamic: when you transform a
graph, its equation is continuously
updated on the screen.
You can create a graph by first roughly
sketching it with the stylus and then
choosing a type of relation that you want the
sketch to represent. Your sketch is then redrawn so that it becomes a
mathematically precise instance of the type of relation you chose. You
can also create a graph by choosing its type from a list and specifying the
constants.
For each graph you create, you can
choose to display a table of the
coordinates of plotted points. You can
modify this table in various ways, and
use it to determine the value(s) of a
dependent variable for a specified value of the independent variable.
You can add various objects to a graph and to the viewing window, trace
a graph, translate and dilate a graph, and zoom in or out on the viewing
window.
You can also take measurements of the geometric objects you add to the
viewing window. These measurements are continuously updated as you
move the underlying objects.
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Accessing Graph Xpander
You access Graph Xpander from
a workbook. Once a workbook
is open, you can:
n

tap on the Graph button
on the tool bar: 1

n

open the File menu, select
Create and then select
Graph: 2 , or

n

tap on a graph label in the
workbook history, 3 , and
select Explore from the
label menu.

3

1

2

If you tap on the Graph button
Figure 5-1: Accessing Graph Xpander
(or choose Graph from the
Create submenu), Graph Xpander opens with a blank window; if you
choose Explore after tapping on a graph label in history, Graph Xpander
opens and displays details of the graph(s) associated with that graph
label (that is, the graph(s) defined by the equation(s) below the label). In
the latter case, you could, for example, draw a new graph over the
existing graph(s).
Unless the graph you display by selecting Explore is the last item in the
workbook, any change you make to it—such as adding a point or
modifying a component equation—will not be saved in the workbook.
Only changes made to the last workbook item are saved.
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Graph Window
The graph window is the window displayed when you open Graph
Expander. It is divided into three panes: the symbolic pane, graph pane,
and table pane. Each pane is separated from an adjacent pane by a sash.

symbolic pane
sash

graph pane

sash
table pane

Figure 5-2: Graph Xpander window

Sashes
A sash is the shaded boundary between two panes (see Figure 5-2 on
page 49). A sash enables you to increase or decrease the size of a pane:
1. Place the stylus on a sash.
2. Drag the stylus up or down.
Dragging the sash up reveals more of the pane below the sash; dragging
the sash down reveals more of the pane above the sash.

Graph Window
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Symbolic pane
The symbolic pane displays the
Figure 5-3: Symbolic pane
equation of each graph. You can
edit the constants in an equation—2, 3, and 4 in the example in
Figure 5-3—by tapping on them and entering new values (see “Changing
the equation of a graph” on page 65). You can also change an equation by
directly changing the corresponding graph (see “Directly manipulating a
graph” on page 65).
There is an equation for each graph displayed. If the equation you want to
see is hidden, tap on the scroll bar at the right of the symbolic pane. (Scroll
bars only appear if there is more information displayed in the symbolic
pane than can fit in its current size.)
Near the right edge of the symbolic pane are two small buttons. One
button— —represents a graph you have plotted, and the other
button— —represents the associated dependent variable column(s) in
the table pane. You can hide and redisplay a graph, or the dependent
variable column(s), by tapping on the corresponding button. A
checkmark to the left of the button indicates that the graph or
dependent variable column(s) are displayed; a cross indicates that they
have been hidden. In the example in Figure 5-3, the graph is displayed,
but the dependent variable column is hidden.

Graph pane
The graph pane is where graphs are
drawn.
The boundary values of the graph pane
are centered along the edges of the graph
pane. In the example in Figure 5-4, these
values indicate that the graph pane
extends from x = –11.5 to x = 11.5, and
from y = –8 to y = 8.

Figure 5-4: Graph pane

You can directly manipulate certain graphs with the stylus (see “Directly
manipulating a graph” on page 65). You can also:
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n

change the boundaries of the viewing window (see “Modifying the
Viewing Window” on page 67)

n

add objects—such as points and segments—to the viewing window
(see “Adding Elements to the Graph Pane” on page 79)

n

take measurements (see “Measurements” on page 82)
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Hiding and redisplaying axes
By default, axes are drawn on the graph pane. To hide the axes:
1. Open the Graph menu.
2. Select Show.
3. Select Axes.
The axes and the boundaries of the graph pane are hidden.
To redisplay hidden axes, follow the same procedure.

Table pane
The table pane displays a table of
coordinate values for points on a graph.
The leftmost column lists values of the
independent variable. The remaining
columns list corresponding values for
the dependent variable for each graph
plotted.

Figure 5-5: Table pane showing
coordinate values

By default, only a single row of values is visible in the table pane. You
need to drag the sash between the graph pane and the table pane
upward to see more rows of the table pane, as in Figure 5-5.
Where you have plotted many graphs, the columns for each graph may
not be visible. You can display more columns either by using the scroll
bar or by reducing the width of one or more columns.
The values of the coordinates listed in the table pane are determined by
your table settings (see “Changing table settings” on page 74). The
vertical scroll bar to the right of the table pane enables you to scroll
through the values in that range.

Graph Window
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Graph window menu map
Copy
Edit

Paste
Delete
Show
Tracer
Select

Graph

Zoom
Pan
Translate
Dilate

Conic...

Linear
Quadratic
Exponential
Logarithmic
Sine
Cosine

Fit Sketch

Power

Settings...

Function...
Plot

Fit Conic

Function
Feature

Geometric
Sketch

Zoom In
Table

Axes
In
Out
Into Box
Integer
Decimal
Trig

Circle
Ellipse
Horizontal Hyperbola
Vertical Hyperbola
Horizontal Parabola
Vertical Parabola
Point on curve
First derivative
Point
Segment
Measurement...
Delete Measurement
Attributes...
Point Trail

Zoom Out
Settings...
Figure 5-6: Graph window menu map

52

Chapter 5: Graphing

Graph window buttons
Button

g
r
o
u
p

g
r
o
u
p

g
r
o
u
p

Name

Description

Workbook

Returns you to the workbook, adding a workbook
item summarizing the graph(s) you have drawn.

Select

Makes the stylus a select tool. Crosshairs are
displayed at the stylus tip when the stylus
becomes a select tool. An object subsequently
tapped becomes selected. You can also select an
object by using the stylus to place the center of
the crosshairs on the object, and then lifting the
stylus. Note that you can select only one object
at a time with the select tool in Graph Xpander.

Pan

Makes the stylus a pan tool. You can now drag
the stylus through the graph pane to modify the
boundary values (see page 70).

Zoom

Makes the stylus a Zoom Into Box tool (see
page 71). A rectangle drawn on the screen
becomes the region zoomed in on.

Translate

Makes the stylus a translation tool. You can now
translate—that is, move—a selected object (see
page 65). The translation tool is only active if an
object is selected.

Dilate

Makes the stylus a dilation tool. You can now
dilate—that is, stretch or shrink—a selected
graph (see page 66). The dilation tool is only
active if an object is selected.

Sketch

Makes the stylus a sketch tool. You can now draw
freehand objects in the graph pane (see page 63).

Point

Makes the stylus a point-creation tool (see
page 79).

Segment

Makes the stylus a segment-creation tool (see
page 80).
Table 5-1: Graph window buttons

Graph Window
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Button

Name

Description

Trace

Activates the trace tool (see page 76). A vertical
trace line is drawn on the screen and a trace
point appears at the intersection of the trace line
and the selected graph.

Help

Displays the contents of the online help.

Table 5-1: Graph window buttons (Cont.)

The Pan and Zoom buttons form a
button group, as do the Translate
and Dilate buttons, and the Sketch,
Point, and Segment buttons. In a
Figure 5-7: Pan and Zoom button group
button group, only one button is
displayed at one time. To display the
other button(s) in the group, hold your stylus on the button. The other
button(s) appear directly below the first button (as in Figure 5-7).
When a second or third button is displayed, it can be selected by tapping
on it. A button you select in this way then becomes the button displayed
for the group.

Plotting Graphs
The types of graphs you can plot are:
n

function, and

n

conic section

There are three ways you can plot a graph:
n

by specifying the equation for the graph (except for conic
sections))

n

by selecting a type of graph from a list, or

n

by roughly sketching the graph with the stylus and converting the
sketch to a mathematically defined graph.

You can draw multiple graphs in the one viewing window, that is,
superimpose one or more graphs over another. However, a maximum of
10 graphs can be plotted in the one viewing window.
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Functions
A function plot is a plot of an equation that returns a unique value for
each value of x. Examples of such equations are y = x2 + 2x + 3 and
y = sin x.
You can plot a function by:
n

specifying the equation of the function

n

selecting a predefined equation from a menu of common functions,
or

n

drawing a sketch and converting it to the graph of a function.

To specify an equation, you choose User-Defined as the type of function
to plot. To plot a predefined equation, you must first select one of seven
categories of equations (see next section). If you want to convert a
sketch to the graph of a function, see “Creating a graph by sketching” on
page 63.

Predefined equations
The functions for which predefined equations are available for selection
are:
n

linear

n

quadratic

n

exponential

n

logarithmic

n

sine

n

cosine, and

n

power.

Plotting Graphs
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The predefined equations are listed in Table 5-2 below.
Function Type

Predefined Equation

linear

y = m(x – h) + k

quadratic

y = a(x – h) + k

2

exponential
n

general

n

natural

x

y = ba + k
y = be

ax

+k

logarithmic

y = b ⋅ln ( a ( x – h ) ) + k

sine

y = b ⋅sin ( a ( x – h ) ) + k

cosine

y = b ⋅cos ( a ( x – h ) ) + k

power

y = a(x – h) + k

r

Table 5-2: Equations of predefined functions

When you choose a predefined function, default values are provided for
the constants a, b, m, h, k, and r. You can change these values, both
before plotting and after plotting.
If you choose to plot a function based on one of the predefined equations
listed in Table 5-2, you can also superimpose the plot of the first
derivative of the equation. See “Adding the first derivative of a function”
on page 81 for detailed instructions.
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Plotting a function
1. If Graph Xpander is not open, open it. (See “Accessing Graph
Xpander” on page 48 for instructions.)
2. Open the Plot menu.
3. Select Function…
The Function Plot dialog box is
displayed. The default function type
is User-Defined.
4. If you want to graph a user-defined
function:
a. Enter the function, using the
math keyboard to assemble the
components. See page 19 for
instructions on using the math
keyboard.
Figure 5-8: Function Plot dialog box

Note that you can define a
function in terms of another function by referring to its label; for
example, x·f3(x + 2).
b. continue from step 8.
5. If you want to graph one of the predefined equations, tap on the
functions menu button to the right of the Type field:
6. Choose the type of function from the
function menu (see Figure 5-9).
If you chose exponential, a submenu
of equations is displayed. Tap on the
equation you want to plot.
The equation you chose now
appears in the text box (see
Figure 5-10).

Plotting Graphs

Figure 5-9: Functions menu
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7. To change a constant, select the
constant and type a new value.
You select a constant by dragging
the stylus over it.
8. You can choose whether or not to
display the graph of the equation
you have specified or selected. You
might, for instance, only be
interested in the coordinates of
points on the graph (which are
displayed in the table pane).

Figure 5-10: Pre-defined function

By default, the graph is displayed.
To suppress the display, clear the Graph check box by tapping on
it.
9. You can also choose whether or not to display a dependent
variable column in the table pane. (See “Table pane” on page 51.)
The range and spread of values displayed is determined by your
table settings (see page 74).
By default, the dependent variable column is not displayed. To
display the column, select the Table check box by tapping on it.
10. Tap on OK.
The equation of your graph appears in the
symbolic pane, the plot is drawn in the
graph pane (if the Graph check box is
selected), and a dependent variable column
is displayed in the table pane (if the Table
check box is selected).
User-defined functions are labeled f1, f2, f3,
… f10 in the symbolic and table panes, while
those based on a predefined equation are
labeled g1, g2, g3, … g10.

Figure 5-11: Sample function
Plot

You can display the graph even if you
earlier chose to suppress it (see step 8). You do this by tapping on
the graph button at the right-hand side of the symbolic pane.
Similarly, you can display a suppressed dependent variable column
by tapping on the table button, also at the right-hand side of the
symbolic pane. The graph and table buttons will also hide a graph
or dependent variable column if it is displayed. (The graph and
table buttons are illustrated on page 50.)
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11. If you have displayed the graph, it will be automatically selected.
(This enables you to immediately transform the graph, or display
the trace point.) To deselect the graph, tap on it.
12. If you want to plot another function in the same viewing window,
repeat the procedure from step 2. If you want to plot a conic section
in the same viewing window, follow the procedure in “Conic section
plots” on page 60.

Related topics. Once you have plotted a function, you can:
n

change the boundaries of the viewing window (see “Modifying the
Viewing Window” on page 67)

n

trace a point along the graph (see “Trace Tool” on page 76)

n

transform the plot, providing it is based on one of the predefined
equations (see “Directly manipulating a graph” on page 65)

n

add graphic objects to the graph pane (see “Adding Elements to the
Graph Pane” on page 79)

n

add the first derivative (see “Adding the first derivative of a
function” on page 81).

Plotting Graphs

59

Conic section plots
The equation for a conic section plot is a polynomial of second degree or
less in both x and y. An example is x2 + y2 = 8. You plot a conic section by
first selecting a predefined type of conic section from a menu of common
types. The predefined types and the associated equations are listed in
Table 5-3 below.
Type

Predefined Equations

circle

(x – h) + (y – k) = r

ellipse

(x – h)
(y – k)
------------------ + ------------------ = 1
2
2
a
b

hyperbola

(x – h) (y – k)
------------------ – ------------------ = 1
2
2
a
b

2

2

2

2

2

2

2

2

2

(y – k) (x – h)
------------------ – ------------------ = 1
2
2
b
a
parabola

2

( x – h ) = 4a ( y – k )
2

( y – k ) = 4a ( x – h )
Table 5-3: Predefined conic section equations

When you choose a conic section equation, Graph Explorer provides
default values for the constants a, b, h, k, and r. You can change these
values, both before and after plotting.
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Plotting a conic section
1. If Graph Xpander is not open, open it. (See “Accessing Graph
Xpander” on page 48 for instructions.)
2. Open the Plot menu.
3. Select Conic…
The Conic Section Plot dialog box
is displayed enabling you to
select your conic section
equation.
4. Tap on the conic section menu
button to the right of the Type
field:
5. The conic section menu gives
you the choice of six conic
section equations. Tap on the
type of equation you want to plot.

Figure 5-12: Conic Section Plot dialog box

The equation you chose now
appears in the text box (see
Figure 5-13). The constants have
their default values.
6. To change a default constant,
select the constant and type a
new value.
You select a constant by dragging
the stylus over it.
7. You can choose whether or not to
Figure 5-13: Pre-defined conic section
display the graph of the equation
you have specified. You might, for
instance, only be interested in the coordinates of points on the
graph (which are displayed in the table pane).
By default, the graph is displayed. To suppress the display, clear
the Graph check box by tapping on it.
8. You can also choose whether or not to display columns for y values.
(These are displayed in the table pane, as described in “Graph
Window” on page 49.) The range of values, and the interval
between them, is determined by your table settings (see page 74).
Note that because there are two y values for each x value in the
case of circles and ellipses, two columns of y values are listed in the
table pane.
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By default, the y value columns are not displayed. To display the
columns, select the Table check box by tapping on it.
9. Tap on OK.
The definition of your plot appears in the
symbolic pane, the plot is drawn in the
graph pane (if you chose to display the
graph), and y values are listed in the table
pane (if you chose to display the y values).
Note that conic section equations are
labeled p1, p2, p3,…p10 in the symbolic
pane. Each equation has two
corresponding columns in the table pane,
pn1 and pn2, where n is the number of the
equation in the symbolic pane.

Figure 5-14: Sample conic
plot

You can display the graph even if you
earlier chose to suppress it (see step 8). You do this by tapping on
the graph button at the right-hand side of the symbolic pane.
Similarly, you can display suppressed y value columns by tapping
on the table button, also at the right-hand side of the symbolic
pane. The graph and table buttons will also hide a graph or y value
columns if they are displayed. (The graph and table buttons are
illustrated on page 50.)
10. If you have displayed the graph, it will be automatically selected.
(This enables you to immediately transform the graph, or display
the trace point.) To deselect the graph, tap on it.
11. If you want to plot another conic section in the same viewing
window, repeat the procedure from step 2. If you want to plot a
function in the same viewing window, follow the procedure in
“Functions” on page 55.

Related topics. Once you have plotted a conic section, you can:
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n

change the boundaries of the viewing window (see “Modifying the
Viewing Window” on page 67)

n

trace a point along the graph (see “Trace Tool” on page 76)

n

transform the plot (see “Directly manipulating a graph” on page 65)

n

add graphic objects to the graph pane (see “Adding Elements to the
Graph Pane” on page 79)
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Creating a graph by sketching
You can create a graph by sketching it with the
stylus and then converting the sketch to a
mathematically defined graph.
1. Tap on the Sketch button:
You can now draw with the stylus.
Selecting Sketch from the Feature menu also
configures the stylus for drawing.
2. Draw a sketch of the graph you want to
create. Keep the stylus in contact with the
screen while you are sketching.

Figure 5-15: Sketch for an
ellipse

3. Open the Plot menu.
4. To fit your sketch to a function, tap on Fit
Function.
A menu is displayed listing the functions
available to convert your sketch to a
mathematically precise graph.
5. To fit your sketch to a conic section, tap on
Fit Conic.
A menu is displayed listing the conic
sections available to convert your sketch to
a mathematically precise graph.

Figure 5-16: Sketch
converted to an ellipse

6. Tap on an equation type.
The sketch is now replaced by a graph of the type you selected.
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Selecting and Deselecting a Graph
You can select a graph by:
n

tapping on the graph label in the symbolic pane, or

n

tapping on the Select button, placing the center of the crosshairs on
the graph you want to select, and then lifting the stylus, or

n

tapping on the heading of the column for an associated dependent
variable in the table pane.
The graph changes to light gray to indicate it is selected. The graph
label and column heading are highlighted to indicate the graph is
selected.

Follow the same procedure to deselect a graph. The graph changes to
black to indicate it is deselected, and the graph label and column
heading are no longer highlighted.

Transforming a Graph
You can transform a graph by way of:
n

translation or

n

dilation.

In translation, a plot undergoes vertical shift, horizontal shift, or a
combination of the two. Both the size and shape of the plot are retained.
In dilation, a plot is shrunk or stretched.
You can transform a graph by changing its equation in the symbolic
pane. You can also transform certain graphs by directly manipulating
them.
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Changing the equation of a graph
After drawing a graph, you can transform it by directly changing the
graph’s equation in the symbolic pane.
1. If the graph you want to modify is not selected, tap on it or on its
equation in the symbolic pane.
2. Tap on the constant that you want to change.
3. Change the value.
4. Tap ENTER on the math keyboard (see page 20).
The graph is redrawn to match your changes. The values of the
dependent variable in the table pane are also updated. (You will
not see this occur if you chose to suppress the display of the
dependent variable column.)
Note that if you change the constants in a user-defined function, the
result may not be equivalent to translation or dilation.

Directly manipulating a graph
If a graph is based on a predefined equation, you can transform it with
the stylus.

Translating a graph
1. If the graph you want to translate is not selected, select it. (See
“Selecting and Deselecting a Graph” on page 64.)
2. Tap on the Translate button:
The Translate button is one of two buttons in the Transform button
group. (Button groups are explained on page 54.) The other button
. If the Dilate button is currently displayed,
is the Dilate button:
hold your stylus on the button for about a second and then tap on
the Translate button.
You can also choose the translate tool by selecting Translate from
the Graph menu.
3. Drag the stylus across the screen. The selected graph moves in the
direction of the stylus.
A copy of the graph remains at its original position until you lift the
stylus from the screen.
As you move the graph, its equation in the symbolic pane
continuously updates to reflect the graph’s new position.
Transforming a Graph
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4. Lift the stylus from the screen when the graph is where you want it
to be.
5. Deselect the graph.
You do this by tapping on the Select button and then on the graph.

Dilating a graph
In dilation, a graph is shrunk or stretched. Each graph is dilated with
respect to its center of dilation. Table 5-4 below gives the center of
dilation for various graph types.
Graph Type

Center of Dilation

exponential

(0, k)

others

(h, k)

Table 5-4: Center of dilation for various graph types

If the graph you wish to dilate is a circle—and was created as a circle—
dilation will always be uniform; that is, the circle will expand or shrink
vertically by the same factor as it shrinks or expands horizontally. With
other graph types—including an ellipse that has become a circle as a
result of an earlier dilation—the degree of expansion or shrinking in a
particular direction depends on how far you move the stylus in that
direction.
1. If the graph you want to dilate is not
selected, tap on the Select button and then
on the graph.
2. Tap on the Dilate button:
The Dilate button is one of two buttons in
the Transform button group. (Button groups
are explained on page 53.) The other button
. If the Translate
is the Translate button:
button is currently displayed, hold your
stylus on the button and then tap on the
Dilate button.

Figure 5-17: Before dilation

You can also choose the dilate tool by
selecting Dilate from the Graph menu.
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3. Drag the stylus across the screen.
Depending on the direction in which you
move the stylus, the selected graph
expands or shrinks. If you move the stylus
away from the center of dilation, the graph
expands; if you move the stylus towards
the center of dilation, the graph shrinks.
The distance you move the stylus
determines the extent of the dilation.
As you dilate the graph, its equation
continuously updates to reflect the new
graph.

Figure 5-18: After dilation

A copy of the graph remains at its original position until you lift the
stylus from the screen.
4. Deselect the plot.
You do this by tapping on the Select button and then on the graph.

Modifying the Viewing Window
The viewing window is the section of the coordinate plane that is
displayed in the graph pane.
There are four ways to change the boundaries of the viewing window:
n

changing Graph Xpander settings

n

directly changing the displayed boundaries

n

panning

n

zooming.

Modifying the Viewing Window
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Changing graph settings
1. Open the Graph menu.
2. Select Settings…
The Graph Settings dialog box is
displayed.

The settings that determine the
boundaries of the viewing window are:

• Horiz Min
• Horiz Max
• Vert Min

Figure 5-19: Graph settings

• Vert max
3. To change the lower boundary of the x axis, select the value in the
Horiz Min field and change it.
4. To change the upper boundary of the x axis, select the value in the
Horiz Max field and change it.
5. To change the lower boundary of the y axis, select the value in the
Vert Min field and change it.
6. To change the upper boundary of the y axis, select the value in the
Vert Max field and change it.
7. Tap on OK to save your changes.
The viewing window changes to match the values you specified in
the Settings dialog box. The limits of the viewing window displayed
on the screen change accordingly.
The Graph Settings dialog box also has fields for the Horiz Tick value and
Vert Tick value (see Figure 5-19). These values—together with the
boundaries of the viewing window—determine how many ticks appear
on each axis. For example, with the viewing window extending
horizontally from x = –10 to x = 10, and a Horiz Tick value of 1, there will
be 21 ticks along the x axis: 10 to the left of the origin, 10 to the right, and
one at the origin (visible only if the axes are off screen).
Therefore, changing the horizontal extent of the viewing window also
changes the spacing between the ticks on the x axes. For example, if you
change the Horiz Min to -23 and Horiz Max to 23, and keep the Horiz Tick
value at 1, there will now be 46 ticks along the x axis.
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The Horiz Tick or Vert Tick value is automatically changed to prevent a
clutter of ticks in the viewing window. For example, if you specify a
Horiz Min value of –46 and a Horiz Max value of 46, the Horiz Tick value is
automatically set to 10, yielding just 9 tick marks, four on either side of
the origin and one at the origin.
The Graph Settings dialog box contains a field—Zoom—that enables you
to set the factors by which you zoom in or zoom out. The default zoom
factor values are 4. Zooming is described in detail in “Zooming” on
page 70.

Changing the boundaries
The boundary values of the viewing window are displayed in the graph
pane, one centered at each edge of the pane (see Figure 5-4). The value
displayed at the far right of the graph pane is the current value for Horiz
Max. Similarly, the value displayed at the bottom of the graph pane is the
current value of Vert Min.
The boundary values can be directly changed:
1. Tap on the boundary value.
The value is highlighted to indicate that it is selected.
2. Enter a new value for the boundary, or an expression for the
boundary that evaluates to a real number.
3. Tap on ENTER.
• The new value is displayed on the graph pane.
• The axes are redrawn to reflect the new viewing window.
• All displayed graphs and graphic objects are redrawn.
• If the new viewing window excludes the x
or y axis, a dotted line appears along the
edge of the screen closest to that axis.
The line will have tick marks spaced
according to the value in the Horiz Tick
or Vert Tick field. In Figure 5-20, the x
axis is excluded by y boundary values of
10 and 20. Although not visible, the x
axis is closer to the bottom edge of the
graph pane than to the top edge;
therefore a dotted line with tick marks is
drawn along the bottom edge of the
pane.
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by dotted line
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Panning
Panning is similar to scrolling, but you use the stylus rather than scroll
bars.
1. Tap on the Pan button:
The Pan button is one of two buttons in a button group. (Button
groups are explained on page 54.) The other button is the Zoom
Into Box button:
. The Zoom Into Box button is currently
displayed, hold the stylus on the button until the Pan button is
displayed, and then tap on the Pan button.
You can also choose Pan from the Graph menu.
The cursor is now the pan tool.
2. Drag the stylus across the screen.
• The graph plane moves in the direction in which you drag the
stylus.
• The boundary values are continuously updated as you drag the
stylus.
3. Tap on another button to deactivate the pan tool.

Zooming
You can also change the viewing window by zooming. You can:
n

zoom in or zoom out by specified factors

n

specify an area of the current viewing window to zoom in on, or

n

choose from a number of preset zoom options.

Zooming in and zooming out
The zoom in function enables you to look at a particular region of the
plot in more detail. The zoom out function enables you to look at more of
the plot than is currently displayed. The factors by which you zoom in or
zoom out are set in the Graph Settings dialog box.
Zooming in divides the horizontal scale by the Horiz Zoom value and the
vertical scale by the Vert Zoom value specified in the Graph Settings
dialog box.
The center of the graph viewing window remains fixed.
To zoom in:
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1. Open the Graph menu.
2. Select Zoom.
The Zoom submenu is displayed.
3. Select In.
Zooming out multiplies the horizontal scale by the Horiz Zoom value and
the vertical scale by the Vert Zoom value specified in the Graph Settings
dialog box.
To zoom out:
1. Open the Graph menu.
2. Select Zoom.
The Zoom submenu is displayed.
3. Select Out.

Specifying a zoom area
1. Tap on the Zoom Into Box button:
The Zoom Into Box button is one of two buttons in a button group.
(Button groups are explained on page 54.) The other button is the
Pan button:
. If the Pan button is currently displayed, hold your
stylus on the button for about a second and then tap on the Zoom
Into Box button.
You can also choose Zoom Into Box from the Zoom submenu
accessible from the Graph menu.
2. Place the stylus at one corner of the region
that you want to zoom in on.
3. Drag the stylus to the diagonally opposite
corner of the region that you want to zoom
in on.
A temporary rectangle is drawn on the
screen to indicate the region you want to
zoom in on. This is the zoom box.

Figure 5-21: Creating a zoom
box
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4. Lift the stylus from the screen.
The region bounded by the zoom box now
fills the entire viewing window, and the
boundary values are updated to indicate
the dimensions of the new viewing window.

Figure 5-22: After zooming in

Choosing a preset zoom
There are three preset zoom options. To choose a preset zoom:
1. Open the Graph menu.
2. Select Zoom.
The Zoom submenu appears. There are three preset options on the
submenu. The options, and their effect on the viewing window, are
listed in the following table:
Zoom option

New Horizontal Boundaries

Integer

[–115, 115]

Decimal

[–11.5, 11.5]

Trig

[–115π/48, 115π/48] (with radians set)
[–431.25, 431.25] (with degrees set)
Table 5-5: Preset zoom options

3. Select a zoom option.
The viewing window changes to the limits set by the zoom option
you chose. All graphs are redrawn accordingly.
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When you choose a Trigonometric, Integer, or Decimal zoom, the Horiz
Tick and Vert Tick values are set as follows:
Zoom option

Horiz Tick value

Vert Tick value

Integer

10

10

Decimal

1

1

Trig (in radians)

π/2

1

Trig (in degrees)

90

1

Table 5-6: Tick mark units after zooming

For example, after a Trig zoom, each tick mark on the x axis represents

π/2 units and each tick mark on the y axis represents one unit, and after an

Integer zoom, each tick mark—on both axes—represents 10 units. A
Decimal zoom returns the viewing window to its default settings.

Modifying the Table View
You can change the values displayed in the table pane by:
n

scrolling

n

changing Graph Xpander settings

n

directly changing a value in the independent variable column

n

zooming.

You can also change the width of a column in the table pane.

Scrolling through the table
To see lesser or greater values in the table, tap on the vertical scroll bar
or scroll arrows, or drag the scroll box in the vertical scroll bar.
To see values in columns not currently visible, tap on the horizontal
scroll bar or scroll arrows, or drag the scroll box in the horizontal scroll
bar.
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73

Changing table settings
The values listed in the table pane are determined by two settings.
To change these settings:
1. Open the Table menu.
2. Select Settings…
The Table Settings dialog is displayed.
The fields that determine the values in the
table pane are:
• Independent Variable Start (default = 0)
• Independent Variable Step (default = 0.1).

Figure 5-23: Table Settings

3. To change the first value in the independent
variable column, change the value in the Independent Variable Start
field.
4. To change the difference between consecutive values in the
independent variable column, change the value in the Independent
Variable Step field.
5. Tap on OK to save your changes.
For example, changing these settings to 3 and 0.5 respectively changes
the default values in the independent variable column from 0, 0.1, 0.2,
0.3, … to 3, 3.5, 4, 4.5, …
The Table Settings dialog also enables you to set the table zoom factor.
(See “Table zooming” on page 75 for detailed information.)

Directly changing table values
1. Tap on a cell in the independent variable column of the table pane.
2. Enter a real number or an expression that evaluates to a real
number.
3. Tap on ENTER.
The value in the cell changes to the number you entered, or to the
number generated by the expression you entered, and:
• all the other values in the independent variable column change
so that the difference between consecutive values remains equal
to the Independent Variable Step value
• all the values in the dependent variable column(s) are updated.
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Table zooming
You can display more detail, or less detail, in
the table by zooming in, or zooming out, on a
selected table row. When you zoom in, the
Independent Variable Step value is divided by
the table zoom factor (see “Changing table
settings” on page 74). With the default table
zoom factor of 10, zooming in once decreases
the default Independent Variable Step value from
0.1 to 0.01; zooming in again reduces the value
to 0.001, and so on.
Figure 5-24: Zooming in

Conversely, when you zoom out, the
Independent variable step value is multiplied by
the table zoom factor. With the default table
zoom factor of 10, zooming out increases the
default Independent Variable Step value from 0.1
to 1.
To zoom in or out:
1. Tap on a cell in the x column.
2. Open the Table menu.
3. Select Zoom In or Zoom Out.
Figure 5-25: Zooming out

The value in the highlighted cell is
retained while the remaining values in the independent variable
column are updated to reflect the new Independent Variable Step
value. The values in the dependent variable columns are also
updated.

Changing column width
To change the width of a column:
1. Hold the stylus on the right edge of the column’s heading.
2. Drag to the left to decrease the column’s width, or to the right to
increase the column’s width.
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Trace Tool
The trace tool enables you to step through plotted points one by one
and have the coordinates of each point visited displayed in the graph
pane. It does this by marking a movable trace point on the plot.

Displaying the trace point
To display the trace point:
1. Select the graph you want to trace.
The graph is highlighted to indicate that it
is selected.
If you don’t select a graph before activating
the trace tool, the trace point will appear
on the x axis and will move only along the x
axis.
2. Tap on the Trace button:
Alternatively, you can select Tracer from
the Graph menu.

Figure 5-26: Trace point on a
function plot

A dotted vertical line is displayed. This is
the trace line.
The point where the trace line intersects the graph is marked (as in
Figure 5-26). This point is called the trace point.
For graphs with two y values for each
x value—for example, circles and ellipses—the
trace point appears on the upper part of the
curve (as in Figure 5-27).
The coordinates of the trace point are displayed
at the bottom of the graph pane. In Figure 5-27,
the coordinates are (1.7, 4.873).
Note that for some graphs, the trace point will
initially be beyond the boundaries of the viewing
window, and therefore not visible. In such cases,
the coordinates of the trace point are still
displayed at the bottom of the graph pane.

Figure 5-27: Trace point on
an ellipse

Where there is no plotted y value for the x value
of the trace line, Undef is displayed as the y value at the bottom of the
graph pane.
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Related topics. Once you have displayed the trace point, you can:
n

remove the trace point (see page 77)

n

move the trace point along a graph (see page 77)

n

move the trace point from one graph to another (see page 78).

Removing the trace point
Tap on the Trace button:
Alternatively, select Tracer from the Graph menu.

Moving the trace point along a plot
You can move the trace point (and trace line) by:
n

dragging the trace line

n

specifying a position for it

n

tapping on the arrow keys on the math keyboard.

Regardless of how you move the trace point, the trace line always
remains perpendicular to the x axis.
Note that no trace point appears if you move the trace line to a position
where there is no y value for the corresponding x value.

Dragging the trace point
1. Tap on the Select button:
2. Place the stylus on the trace line.
3. Drag the line to the desired location.
The trace point and trace line move to match the x coordinate of
the stylus.
The trace point information at the bottom of the graph pane is
continuously updated to match the coordinates of the trace point.

Trace Tool
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Specifying the position of the trace point
The coordinates of the trace point are displayed in an information box at
the bottom of the graph pane. You can move the trace point by directly
changing the value of the independent variable in this box (that is, the
value labelled X:).
1. Tap on the independent variable value in the information box.
The value is highlighted to indicate that it is selected.
2. Enter a new value for the independent variable.
The value you enter can be beyond the boundaries of the viewing
window; but in this case the trace line will not be visible.
3. Tap on ENTER.
The trace line moves to the specified location. In addition, the trace
point information box displays the new location of the trace point.
You can use this method to calculate the value of the dependent
variable for a specified value of the independent variable.

Using the arrow keys to move the trace point
Tapping on ß or à on the math keyboard moves the trace line one pixel
left or one pixel right respectively. The trace point moves accordingly, and
the trace point information box is updated with each tap.

Moving the trace point to another plot
The trace point appears on whatever graph you selected before
choosing the Trace tool. To move the trace point to another graph:
1. Tap on the Select button:
2. Select the graph.
The trace point moves to the intersection of the selected graph and the
vertical trace line. The old coordinate display is replaced by the
coordinates of the new trace point.
You can also move the trace point to another graph by tapping on á or
â on the math keyboard. The trace point moves to the next, or previous,
graph in the order in which graphs are listed in the symbolic pane.
If the trace point is on a branch of a conic section, tapping on á or â
moves the trace point to the other branch in the direction of the arrow.
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Adding Elements to the Graph Pane
Adding points
You can add points to a graph. You can also add points to the viewing
window that are not on a graph.
Points are either analytic or geometric. Analytic points are points that
you attach to a graph and are transformed with the graph when the
graph is transformed. Geometric points are points that are independent
of a graph. You can place a geometric point on a graph, but if you
transform the graph, the point remains at its position. Geometric points
can be placed anywhere within the viewing window.

Adding an analytic point
1. If a trace point is not displayed, display it.
2. Move the trace point to the position where you want to attach the
point.
3. Open the Feature menu.
4. Select Function.
5. Select Point on curve.
An analytic point is added to the graph. The point will be selected.
Initially, the trace point and analytic point coincide; but if you move the
trace point, the analytic point remains at the location at which it was
created.

Adding Elements to the Graph Pane
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Adding a geometric point
A geometric point is a point that is independent of a graph. Unlike an
analytic point, a geometric point does not move if a graph is
transformed. Conversely, you can move a geometric point without
necessarily moving a graph.
To add a geometric point:
1. Open the Feature menu.
2. Select Geometric.
The Geometric submenu is displayed.
3. Select Point.
4. Tap the stylus on the graph pane where you
want the point to be. The point will be
selected.
Each geometric point you create is labeled: A, B,
C, and so on.
You can move a geometric point by selecting it
and using the translate tool (see “Translating a
graph” on page 65).

Figure 5-28: Adding a
geometric point

Adding segments
1. Open the Feature menu.
2. Select Geometric.
The Geometric submenu is displayed.
3. Select Segment.
4. Drag the stylus across the pane.
As you drag, a segment is created along the
trail of the stylus.
5. To complete the segment, lift the stylus
from the screen.
A point is created at each end of the
segment. The points are labeled.

Figure 5-29: Drawing a
segment

You can add a segment between existing points. Select the segment tool
and start dragging from one point to another. The points become the
endpoints of the segment and will move with the segment if the segment
is moved. Note that you do not need to start, or end, precisely on a point.
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As long as you are close to a point, the point will be converted to the
endpoint of the segment.
You can also add a segment by dragging the stylus to, or from, an
existing point. For example, you can add a segment that begins or ends
on the trace point. In this case, the segment will move as you move the
trace point. (To disengage the segment from the trace point, you could
add an analytic point to the graph at the position of the trace point. The
analytic point becomes the end point of the segment and will not move
as the trace point moves. See “Adding an analytic point” on page 79.)

Adding the first derivative of a function
If you base a plotted function on one of the predefined equations listed in
Table 5-2, you can also plot the first derivative of the function. The graph
of the first derivative is superimposed over the graph of the function.
1. If the graph whose first derivative you want
to plot is not selected, tap on the Select
button and then on the graph.
2. Open the Feature menu.
3. Open the Function submenu.
4. Select First derivative.
The graph of the first derivative is drawn in
the graph pane and its equation appears in
the symbolic pane. The equation is labeled
dgn, where n is the number of the function
on which the first derivative is based.

Figure 5-30: Adding the first
derivative of y = sin x

By tapping on the table button to the right
of the equation in the symbolic pane, you can display a column of
coordinate points for the first derivative in the table pane.
The graph of the first derivative is transformed if the graph on which it is
based is transformed. It also changes to reflect any changes you directly
make to the equation of the function on which it is based.
Note that if you delete the graph on which the first derivative is based,
the graph of the first derivative is also deleted. However, you can delete
the graph of the first derivative without deleting the graph on which it is
based.

Adding Elements to the Graph Pane
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Adding freehand objects
You can add freehand objects to the graph pane.
You could, for example, draw arrows or circle
particular features.
1. Tap on the Sketch button:
The stylus is now a sketch tool.
2. With the stylus, draw an object. The object
you create will be selected.
If you lift the stylus from the window, you
will need to tap on the Sketch button again
to add further freehand objects.

Figure 5-31: Sample
freehand object

Measurements
You can measure various properties of the objects you create in the
graph pane. These measurements are the slope, angle of inclination, and
length of a segment, and the x and y coordinates of a point.
To display a measurement:
1. Select a point or segment in the graph pane.
The object is highlighted to indicate that it
is selected.
2. Open the Feature menu.
3. Select Geometric.
The Geometric submenu is displayed.
4. Select Measurement.
A pop-up menu is displayed listing the
measurement options available.

Figure 5-32: Measuring the
slope of a segment

5. Select an option (see Table 5-7 below).
The measurement is displayed on the screen.
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The measurement options available depend on the type of object
selected. The possibilities are set out in the following table. Each
measurement is labeled on the screen. In the following table, the labels
refer to a point A and to segment AB.
Object selected

geometric point

segment

Measurements available

Label

n

x coordinate

n

xA

n

y coordinate

n

yA

n

angle of inclination

n

iAB

n

length

n

lAB

n

slope

n

mAB

Table 5-7: Measurements of object properties

Deleting a measurement
To delete all measurements of an object:
1. Select the object.
2. Open the Feature menu.
3. Select Geometric.
The Geometric submenu is displayed.
4. Select Delete Measurement.

Measurements
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Attributes
You can also view a point’s coordinates—or a segment’s length and
angle of inclination—by displaying it’s attributes. In this case, the values
of the measurements are displayed in a dialog box, not on the window.
The values in the dialog box can be changed, and the underlying object
changes accordingly.
To display the attributes of a point or segment:
1. Select the point or segment.
2. Open the Feature menu.
3. Select Geometric.
The Geometric submenu is displayed.
4. Select Attributes.
A dialog box is displayed showing the
attributes of the point or segment you
selected.
5. To change an attribute, select the current
value and enter a new value.
6. To constrain the point to have the
coordinates specified, select the
Constraint check box.
7. To save your changes, tap on OK.
The selected object changes to match the
value of the attribute(s) you changed.
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Figure 5-33: Point attributes
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Point Trail
You can choose to draw the path of a point as the point moves. The path
is known as a point trail. You can draw the trail of both analytic and
geometric points.
1. Select the point.
2. Open the Feature menu.
3. Select Geometric.
The Geometric submenu is displayed.
4. Select Point Trail.
As the point moves, a trail is left on the screen to indicate its
previous positions.

Deleting an Object
To delete a graph, point, or segment:
1. Select the object you want to delete.
2. Open the Edit menu.
3. Select Delete.
You can also delete a selected object by tapping on the ïDEL key on the
math keyboard.

Point Trail
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Chapter 6

E x p lo r i n g G e o m e t r y
Geometry Xpander provides a tool for
creating, manipulating, and exploring
geometric constructions. You can create a
variety of geometric objects, enforce
attribute and object constraints, take
measurements, make calculations based on
attributes, and sketch freehand objects.

Accessing Geometry Xpander
You access Geometry Xpander
from a workbook. Once a
workbook is open, you can:
n

tap on the Geometry
button on the tool bar:

1

n

open the File menu, select
Create and then select
Construction: 2 , or

n

tap on a geometry label in
the workbook history and
select Explore from the
label menu: 3 .

3

1

2

If you tap on the Geometry
Figure 6-1: Accessing Geometry Xpander
button (or choose Construction
from the Create submenu), Geometry Xpander opens with a blank
window; if you choose Explore after tapping on a geometry label in
history, Geometry Xpander opens and displays details of the geometric
construction associated with that label.
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Geometry Window
The geometry window is divided into three panes: construction pane,
message pane, and formula pane. Each pane is separated from an
adjacent pane by a sash.

construction
pane

top sash
formula pane

bottom sash

Figure 6-2: Default geometry window

Panes
The construction pane is where you create and manipulate geometric
objects.
The message pane provides messages to help you complete certain
tasks (such as transformations).
The formula pane lists the dynamic attribute definitions and
calculations you create, and provides a way for you to edit or delete
them. Initially, the formula pane is hidden. It becomes visible once you
create a dynamic attribute or calculation. You can also make it visible,
and increase its size, by dragging the top sash upward.

Sashes
A sash is the shaded boundary between two panes. The top sash enables
you to increase or decrease the size of the construction pane and
formula pane:
1. Place the stylus on the top sash.
2. Drag the stylus up or down.
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Dragging the sash up reveals more of the formula pane; dragging the
sash down reveals more of the construction pane. In both instances, the
message pane remains the same size.

Displaying and hiding axes
By default, the construction pane does not
display axes and boundary values.
To display the axes and boundary values:
1. Open the Display menu.
2. Select Axes.
Repeat the procedure to hide the axes and
boundary values.
Figure 6-3: Geometry window
with axes and boundary
values

Settings
To change the boundary values, tick mark spacing, angle unit setting, or
timer speed:
1. Open the Display menu.
2. Select Settings
The Geometry Settings dialog box is
displayed.

The settings that determine the boundaries
of the viewing window are:

• Horizontal Min
• Horizontal Max
• Vertical Min
• Vertical Max

Figure 6-4: Geometry
Settings dialog box

Only the first three of these four settings
can be changed.
3. To change the lower boundary of the x axis, select the value in the
Horizontal Min field and change it.

Geometry Window
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4. To change the upper boundary of the x axis, select the value in the
Horizontal Max field and change it.
5. To change the lower boundary of the y axis, select the value in the
Vertical Min field and change it.
6. Tap on OK to save your changes.
The viewing window changes to match the values you specified in
the Geometry Settings dialog box. The limits of the viewing window
displayed on the screen change accordingly.
The Geometry Settings dialog box also has fields for the Horizontal Tick
value and Vertical Tick value. These values—together with the
boundaries of the viewing window—determine how many ticks appear
on each axis if you choose to display the axes.
The Geometry Settings dialog box also enables you to:
n

specify the units in which angle measurements will be interpreted:
degrees or radians, and

n

alter the timer speed (which has the effect of speeding up, or
slowing down, geometric animations: see page 109).

Note: unlike in Graph Xpander, you cannot directly change a boundary
value on the construction pane by tapping on it and entering a new
value.
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Geometry window menu map
Copy
Paste
Delete

Edit

Undo
Select All
Deselect All
Start/Stop timer
Axes
Attributes...
Dynamic attribute
Measurement...

Display

Delete Measurement
Calculation...
Settings...

Constraint

Point Trail

Point on Object

Points

Intersection Point

Perpendicular

Midpoint

Tangent
Congruent
Remove Contraint

Transform

Dilate
Translate
Rotate
Reflect
Figure 6-5: Geometry window menu map

Geometry Window
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Geometry window buttons
Button

g
r
o
u
p

g
r
o
u
p
g
r
o
u
p

Name

Description

Workbook

Returns you to the workbook, adding a
workbook item that represents your
construction.

Select

Makes the stylus a select tool. Objects
subsequently tapped become selected.
Note that you can select any number of
objects with the select tool in Geometry
Xpander.

Pan

Makes the stylus a pan tool. You can now
drag the stylus to view other regions of the
geometry window.

Move

For moving selected objects.

Point

For adding a point.

Sketch

For drawing objects freehand.

Angle

For creating an angle from three points.

Segment

For adding a segment.

Ray

For adding a ray.

Line

For adding a line.

Circle

For adding a circle.

Polygon

For adding a polygon.
Table 6-1: Geometry window buttons
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Many buttons—for example, the
point, sketch, and angle buttons—
form a button group. In a button
group, only one button is displayed
at one time. To display the other
button(s) in the group, hold your
stylus on the button. The other
button(s) appear directly below the
first button (as in Figure 6-6).

Figure 6-6: Point, sketch, and angle button
group

When a second or third button is displayed, you can select it by tapping
on the button. A button you select in this way then becomes the button
displayed for the group.

Creating Objects
Geometry Xpander provides special tools for creating seven basic
objects:
n

point tool

n

angle tool

n

segment tool

n

ray tool

n

line tool

n

circle tool

n

polygon tool

To create an object, first tap on the corresponding button (see page 92).
Once activated, an object tool remains active only while you are drawing
one object; that is, if you want to draw, say, two circles, you will need to
activate the circle tool twice.
When you create an object, the object is automatically selected. Objects
that were selected at the time you created the new object are
automatically deselected.

Creating Objects
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Creating a point
1. Tap on the Point button:
The Point button is part of a button group
(see “Geometry window buttons” on
page 92).
2. Tap on the construction pane where you
want the point to be created.
A point is created. It is labeled with a letter
of the alphabet: A, B, C, D, and so on.
3. To deselect the point, tap on it or on its
label.

Figure 6-7: New point and
label

Creating an angle
You can create an angle from three existing
points.
1. Tap on the Angle button:
The Angle button is part of a button group
(see “Geometry window buttons” on
page 92).
2. Select a point on the first defining side
other than the vertex.
3. Select the point that is to be the vertex.
4. Select a point on the second defining side.

Figure 6-8: New angle and
labels

5. To deselect the angle, tap on it.
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Creating a segment
1. Tap on the Segment button:
The Segment button is part of a button
group (see “Geometry window buttons” on
page 92).
2. Place the stylus on the window where you
want the segment to begin and drag to
where you want the segment to end.
A segment is drawn from the starting point
to the tip of the stylus as you drag the
stylus.
3. Lift the stylus where you want the segment
to end.

Figure 6-9: New segment and
labels

A labeled point is added to each end of the segment.
Note that if the starting location or ending location is close to an
existing point, the existing point is used as an endpoint of the
segment.
4. To deselect the segment, tap on it.

Creating a ray
1. Tap on the Ray button:
The Ray button is part of a button group
(see “Geometry window buttons” on
page 92).
2. Place the stylus on the window where you
want the ray to begin and drag to another
location that will be on the ray you are
about to create.
3. Lift the stylus.
Labeled points are created at the start and
end location, and a ray is drawn from the
starting point through the end point.

Creating Objects

Figure 6-10: New ray and
labels
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Note that if the starting location or ending location is close to an
existing point, the existing point is used as a defining point of the
ray.
4. To deselect the ray, tap on it.

Creating a line
1. Tap on the Line button:
The Line button is part of a button group (see “Geometry window
buttons” on page 92).
2. Place the stylus on the window at a
location that will be on the line you want to
create and drag to another location that
will be on the line.
3. Lift the stylus.
Labeled points are created at the start and
end location and a line is drawn through
these points.
Note that if the starting location or ending
location is close to an existing point, the
existing point is used as a defining point of
the line.

Figure 6-11: New line and
labels

4. To deselect the line, tap on it.
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Creating a circle
1. Tap on the Circle button:
2. Place the stylus on the window where you want the center of the
circle to be.
3. Drag the stylus to a location that is to be on
the circumference of the circle you want to
draw.
4. Lift the stylus.
A circle, centered on the first location and
passing through the second location, is
created. In addition, labeled points are
created at the two locations.
Note that if the starting location or ending
location is close to an existing point, the
existing point is used as a defining point of
the circle.

Figure 6-12: New circle and
labels

5. To deselect the circle, tap on it.

Creating a polygon
1. Tap on the Polygon button:
The Polygon button is part of a button group (see “Geometry
window buttons” on page 92).
2. Place the stylus on the construction pane
where you want the first segment to begin
and drag to where you want the first
segment to end.
A segment is drawn from the starting point
to the tip of the stylus as you drag the
stylus.
3. Lift the stylus where you want the first
segment to end.
A labeled point is added to each end of the
segment.

Creating Objects

Figure 6-13: New segment
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4. Tap on the construction pane where you want the next segment to
end.
Another segment is drawn. The starting point is the endpoint of the
previously created segment.
5. Repeat step 4 to create as many additional segments as required.
6. Complete the polygon by tapping on the starting point of the first
segment.
7. To deselect the polygon, tap on it.
Note that if any side of the polygon begins or ends close to an
existing point, the existing point is used as a defining point of the
segment. An existing segment can also be used as a side of a
polygon.

Adding freehand objects
You can add freehand objects to the geometry window. You could, for
example, draw arrows or circle particular features.
1. Tap on the Sketch button:
The Sketch button is part of a button group (see “Geometry window
buttons” on page 92).
The stylus is now a sketch tool.
2. With the stylus, draw an object.
If you lift the stylus from the window, you will need to tap on the
Sketch button again to add further freehand objects.
3. To deselect the object, tap on it.
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Selecting and Deselecting Objects
Selecting
You can select an object by tapping on the Select button, and then:
n

tapping on the object with the stylus, or

n

using the stylus to place the center of the crosshairs on the object
you want to select, and then lifting the stylus, or

n

in the case of a point, tapping on its label.

The object changes to light gray to indicate it is selected.

To quickly select all objects, choose Select All from the Edit menu.
If you want to select an object that is close to
another object, hold the stylus near the objects.
A pop-up menu is displayed listing all the
objects in the vicinity of the stylus point (as in
Figure 6-14). You can select an object by
choosing it from the pop-up menu. (If an object
is currently selected, it has a check mark beside
it, as is the case of point B in Figure 6-14.)
Note that an object is automatically selected
when you create it.

Deselecting

Figure 6-14: Selection pop-up
menu

To deselect an object, tap on it (or, in the case of
a point, on its label). To quickly deselect all selected objects, choose
Deselect All from the Edit menu.

Selecting and Deselecting Objects
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Transforming an object
You can transform one or more objects by:
n

translation

n

dilation

n

rotation

n

reflection

These options are available from the Transform menu.
When you apply a transformation option chosen from the Transform
menu, the objects you select are retained in their original position and
an image of them is created based on the type of transformation
selected. The objects and their image remain linked. If you change the
object, the image is changed so that the transformation relation between
the two is retained. Similarly, if you change the image, the object on
which it is based changes so as to retain their transformation relation.
There is one form of transformation that does not generate an image of
the object but acts directly on the object. This is translation using the
stylus, which has the effect simply of moving a selected object without
creating an image of it. This form of translation is applied using the Move
button (see page 92) and is not available from the Transform menu.

Translation
In translation, selected objects undergo vertical shift, horizontal shift, or
a combination of both. Both the size and the shape of each object is
retained.
There are two ways to translate an object:
n

by dragging the object to a new position with the stylus, or

n

by specifying a new position for the object.

If you specify a new position for the object, a copy of the object remains
in its original position.
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Method 1: translation using the stylus
1. Select the object(s) you want to translate.
2. Tap on the Move button:

.

3. Drag the stylus across the screen. The selected objects move in the
direction of the stylus.
A copy of each selected object remains at its original position until
you lift the stylus from the screen.
As you move the objects, any measurements or calculations based
on the objects are continuously updated.
4. Lift the stylus from the screen when the objects are where you want
them to be.
5. Deselect the objects.
You do this by tapping on the Select button and then on the objects,
or by selecting Deselect All from the Edit menu.

Method 2: translation by specification
If you translate objects using the stylus—see method 1 above—a copy of
each object remains at its original position only until you lift the stylus
from the screen. If you translate objects by specification, each selected
object remains at its original position after translation. In effect,
translation by specification creates an image of each selected object,
with the image offset by a horizontal and a vertical distance that you
specify.
1. Open the Transform menu.
2. Select Translate.
3. Select the object(s) you want to translate.
4. Tap on Next.
The Define Translation dialog box is
displayed.
5. In the Dx box, enter the horizontal distance
from each selected object to where you
want the image of each object placed.

Figure 6-15: Define
Translation dialog box

6. In the Dy box, enter the vertical distance
from each selected object to where you
want the image of each object placed.

Transforming an object
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7. Tap on OK.
8. Tap on Next.
An image of each selected object is placed
at the position indicated by the values you
entered in the Dx and Dy fields. The
original objects remain at their pretranslated position. They retain their
original labels, while the labels of the
images are given numeric suffixes (such as
A1, B1, C1, and so on, as in Figure 6-16).
Figure 6-16: Translation

Dilation
In dilation, a shrunk or stretched image of an object is created. The
image is positioned relative to a specified center of dilation.
1. Open the Transform menu.
2. Select Dilate.
3. Select the object(s) you want to create a dilated image of.
4. Tap on Next.
The Define Dilation dialog box is displayed.
5. In the Scale box, enter a value for the scale factor.
The scale factor can be any positive real
number. For example, a scale factor of 0.5
creates an image that is half the size of the
selected object, while a scale factor of 2
creates an image that is twice the size of
the selected object.
6. Tap on OK.
7. Select a point to be the center of the
dilation.
8. Tap on Next.

Figure 6-17: Dilation

An image of each selected object is
created, with a size and position determined by the scale factor and
center of dilation you specified.
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Rotation
In rotation, a image of each selected object is created at a specified angle
to the object on which it is based. The size and the shape of each image
matches the object.
1. Open the Transform menu.
2. Select Rotate.
3. Select the object(s) you want to create a rotated image of.
4. Tap on Next.
The Define Rotation dialog box is displayed.
5. In the Angle box, enter the angle by which
you want the images placed relative to
each object’s original position.
A positive value rotates the selected
objects clockwise, while negative values
rotate the objects counterclockwise.
6. Tap on OK.
7. Select a point to be the center of the
rotation.
8. Tap on Next.
Figure 6-18: Rotation

An image of each selected object is created
at an angle and position determined by the angle and center of
rotation you specified.

Transforming an object
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Reflection
In reflection, a mirror image of each selected object is created over a
specified line of reflection. The size and the shape of each image
matches the object on which it is based.
1. Open the Transform menu.
2. Select Reflect.
3. Select the object(s) you want to create a mirror image of.
4. Tap on Next.
5. Select a line to be the line of reflection.
6. Tap on Next.
A mirror image of each selected object is
created across the line of reflection.

Figure 6-19: Reflection
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Viewing and Changing an Object’s
Attributes
With the exception of polygons, you can display various attributes of the
objects you create. These attributes can be directly changed, thereby
changing the associated objects. You can also change an attribute
indirectly by making its value dependent on the values of other
attributes (as explained in “Dynamic Attributes” on page 108).
Object

Attribute

point

n

x and y coordinates

angle

n

angle

segment

n

length

n

angle of inclination

ray

n

angle of inclination

line

n

angle of inclination

circle

n

radius

Table 6-2: Attributes that can be directly changed

To view and directly change an object’s
attribute:
1. Select the object.
2. Open the Display menu.
3. Tap on Attributes….
A dialog box is displayed listing the
object’s attributes.

Figure 6-20: Attribute listing
for a segment

4. Select the value that you want to change.
5. Change the attribute’s value.
6. To constrain the attribute to the set value, tap on the Constraint
check box.
7. If another attribute is displayed and you want to change its value,
repeat from step 5.
8. Tap on OK.
The object is redrawn to match each attribute value you set.
Viewing and Changing an Object’s Attributes
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Taking Measurements
In addition to determining the various attributes of objects (see “Viewing
and Changing an Object’s Attributes” on page 105), you can also measure
various features of objects or groups of objects. Unlike attributes,
measurements are displayed on the screen rather than in a dialog box.
The measurement options available depend on the type of object
selected. The possibilities are set out in the following table. Each
measurement is labeled on the screen. In the following table, the labels
refer to a point P, segment PQ, ray PQ, line PQ, circle PQ, polygon PQRS,
and angle PQR.
Object selected

point

segment

ray or line

circle

polygon

angle

Measurements available

Label

n

x coordinate

n

xP

n

y coordinate

n

yP

n

angle of inclination

n

iPQ

n

length

n

lPQ

n

slope

n

mPQ

n

angle of inclination

n

iPQ

n

slope

n

mPQ

n

area

n

aPQ

n

circumference

n

cPQ

n

radius

n

rPQ

n

area

n

aPQRS

n

perimeter

n

pPQRS

n

angle

n

mvPQR

Table 6-3: Measurements of objects
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The value of a measurement is automatically
updated if an object on which the measurement
is based is transformed in a way that changes
that measurement.
To take a measurement of an object:
1. Deselect any other object that is selected.
2. Select the object you want to measure.
Only one object can be measured at a time.
3. Open the Display menu.
4. Select Measurement….

Figure 6-21: Available
segment measurements

A menu of measurements available for the
selected object is displayed (as in
Figure 6-21).
5. Select the measurement you want to take.
The measurement is displayed on the
screen (see Figure 6-22) along with a label
that identifies the measurement (see
Table 6-3 above).

Figure 6-22: Segment slope

Deleting measurements
To delete measurements:
1. Select the associated object.
2. Open the Display menu.
3. Select Delete Measurement.
All the measurements associated with the selected object are deleted,
but the object remains.

Taking Measurements
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Dynamic Attributes
As well as directly changing the value of an attribute, you can make the
value of an attribute dependent on the value of some other attribute. You
can also make the value of an attribute dependent on a special variable,
t, which represents ticks of the timer. This variable enables you to
animate objects (see page 109).
To make an attribute dynamic—that is, dependent on the value of one or
more other attributes:
1. Select the object with the attribute you want to make dynamic.
2. Open the Display menu.
3. Select Dynamic Attribute.
The Define Calculation dialog box is
displayed.
4. From the Name drop-down list, select the
attribute that you want to make dynamic.
Only the available attributes of the object
you selected—as set out in Table 6-2 on
page 105—are available from the Name
drop-down list.
5. Tap in the Formula box and enter the
expression that is to determine the value of
the chosen attribute.

Figure 6-23: Dynamic Attribute
dialog box

You can build your expression from a list of
measurements, combining them if
necessary with the operators available on
the math keyboard. (See Table 6-3 on
page 106 for the meaning of each
measurement suffix.) To select a
measurement, tap on it in the
Measurements list.
In the example in Figure 6-24, the dynamic
attribute is the length of segment AB, and it
Figure 6-24: Sample formula
has been made equal to 3 times the length
of segment CD. Now whenever the length of
CD changes, the length of AB will change to preserve the
relationship specified in the formula.
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By default, all possible measurements of all objects in the geometry
window are displayed in the Measurements list. If you want to see
listed only those measurements you have taken yourself, tap on the
Created checkbox.
6. When you have finished constructing your
expression, tap on OK.
The object with the dynamic attribute you
have created is redrawn to match the
expression you entered. In addition, the
expression is evaluated and the result
displayed in the formula pane near the
bottom of the geometry window (as in
Figure 6-25).
The object is now constrained by the
values of the attributes on which its
dynamic iterate is based.

Figure 6-25: Effect of making
the length of AB dynamic

Animation
If you have all measurements listed in the Measurements list on the
Dynamic Attribute dialog box, the very last item in the list is the special
variable t. This measurement—which represents the number of ticks per
second of the timer—can be included in an expression that defines a
dynamic attribute.
For example, if you make a segment’s angle of inclination equal to t, you
can force the segment to rotate by one angle unit—that is, one degree or
one radian, depending on your angle setting—with every tick of the
timer. Similarly, if you make the segment’s angle of inclination equal to
5·t, you can force the segment to rotate by five angle units with every tick
of the timer.
To create an animation:
1. Create one or more dynamic attributes each of which is based on
the special variable t.
See “Dynamic Attributes” on page 108 for instructions.
2. Open the Edit menu.
3. Select Start Timer.
You can make an animation proceed slower or faster by adjusting
the timer speed on the Geometry Settings dialog (see “Settings” on
page 89). For example, increasing the timer speed increases the
number of timer ticks per second.
Dynamic Attributes
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To stop an animation:
1. Open the Edit menu.
2. Select Stop Timer.

Editing and deleting dynamic attributes
The formula for each dynamic attribute you create is listed in the
formula pane near the bottom of the geometry window. If you want to
edit or delete a formula, you need to first tap on it in this pane.
Initially, there is room to display only one formula in the formula pane. If
there are formulas, you can display them by either:
n

tapping on the scroll arrows to the right of the displayed formula to
scroll through the list of formulas, or

n

dragging the sash at the bottom of the construction pane upward to
reveal more formulas.

Editing
1. In the formula pane, tap on the formula you want to edit.
A pop-up menu is displayed, with two options: Edit and Delete.
2. Tap on Edit.
The Dynamic Attribute dialog box is displayed (see page 108).
3. Modify the expression in the Calculation box.
4. Tap on OK.

Deleting
1. In the formula pane, tap on the formula you want to delete.
A pop-up menu is displayed, with two options: Edit and Delete.
2. Tap on Delete.
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Calculations
You can perform calculations based on the values of attributes. This is
similar to creating a dynamic attribute (see page 108), but in this case
you are simply evaluating an expression rather than constraining an
attribute to the result of an expression.
1. Open the Display menu.
2. Select Calculation…
The Define Calculation dialog box is
displayed.
3. In the Name box, enter a name for the
calculation.
There are no restrictions on the names you
can give your calculations.
4. Tap in the Calculation box and enter the
components of your calculation.

Figure 6-26: Calculation
dialog box

You can build your calculation from the list
of measurements at the bottom of the dialog box, combining them if
necessary with the operators available on the math keyboard. (See
Table 6-3 on page 106 for the meaning of each measurement suffix.)
To select a measurement, tap on it in the Measurements list.
By default, all possible measurements of all objects in the geometry
window are displayed in the Measurements list. If you want to see
listed just those measurements you have taken yourself, tap on the
Created checkbox.
5. When you have finished constructing your calculation, tap on OK.
The expression is evaluated and the result displayed in the formula
pane, together with any dynamic attribute formulas you have
created.
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Editing and deleting calculations
Editing
1. In the formula pane, tap on the calculation you want to edit.
A pop-up menu is displayed, with two options: Edit and Delete.
2. Tap on Edit.
The Calculation dialog box is displayed (see page 108).
3. Modify the expression in the Calculation box.
4. Tap on OK.

Deleting
1. In the formula pane, tap on the calculation you want to delete.
A pop-up menu is displayed, with two options: Edit and Delete.
2. Tap on Delete.

Creating Object Constraints
As well as constraining the attributes of an object to specified values,
you can constrain multiple objects to particular configurations.

Creating a point on an object
To create a constrained point on an object—that is, a point that remains
on the object if you move the object—the object and a point must
already exist.
1. Select the object on which you want to add a point.
2. Select the point that you want to constrain to the object.
3. Open the Constraint menu.
4. Select Points.
5. Select Point on Object.
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The point moves to the object and is constrained to remain on the
object.

Figure 6-27: Object and point
before constraint

Figure 6-28: Object and point
after constraint

Creating a point at an intersection
1. Select two intersecting objects.
2. Open the Constraint menu.
3. Select Points.
4. Select Intersection Point.
A point is created at each intersection of
the objects.
The two objects are constrained to always
intersect. If you move one or both objects,
there will always be as many points of
intersection as there were when you
created the intersection points.

Creating Object Constraints

Figure 6-29: Point marking
intersection
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Creating a midpoint on a segment
To create a point constrained to be midway along a segment, the object
and a point must already exist. The point does not need to be on the
segment before beginning this procedure.
The midpoint of a segment is constrained by the length of the segment. If
you change the length of the segment, the midpoint will move so that it
remains at the center of the segment.
1. Select the segment.
2. Select a point.
3. Open the Constraint menu.
4. Select Points.
5. Select Midpoint.
The point moves to a position midway along the length of the
segment.

Figure 6-30: Segment and
point before constraint
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Figure 6-31: Segment and
point after constraint
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Creating congruent segments
You can constrain two segments so that they always have the same
length. If you change the length of one segment, the length of the other
segment automatically changes to match it.
After you apply the constraint, the two segments take on the length of
the segment you created first.
1. Select the two segments.
2. Select Constraint.
3. Select Congruent.

Figure 6-32: Segments before
constraint

Creating Object Constraints

Figure 6-33: Segments after
constraint
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Creating congruent angles
You can constrain two angles so that they are always equal in angular
measure. If you change the angle of one, the angle of the other
automatically changes to match it.
After you apply the constraint, the two angles have the measure of the
the angle you created first.
1. Select the two angles.
2. Select Constraint.
3. Select Congruent.

Figure 6-34: Angles before
constraint
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Figure 6-35: Angles after
constraint
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Creating a perpendicular line
To make a segment, ray, or line perpendicular to another segment, ray, or
line, both objects must already exist.
After you apply the constraint, the more recently created object is made
perpendicular to the earlier created object.
1. Select a segment, ray, or line.
2. Select another segment, ray, or line.
3. Open the Constraint menu.
4. Tap on Perpendicular.

Figure 6-36: Two segments

Creating Object Constraints

Figure 6-37: Segments made
perpendicular
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Creating a tangent
You can make a segment, ray, or line, tangent to a circle. You must
already have created the segment, ray, or line, and the circle.
1. Select the circle.
2. Select the segment, ray, or line.
3. Open the Constraint menu.
4. Select Tangent.

Figure 6-38: Circle and
segment

Figure 6-39: Circle and
tangent line

Removing Constraints
You can remove a constraint between two objects.
1. Select the object which has a constraint you want to remove.
2. Open the Constraint menu.
3. Select Remove Constraints.
A list of the object’s constraints is displayed.
4. Tap on a constraint that you want to remove.
5. Tap on Remove.
The constraints list closes and the selected constraint is removed.
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You can also remove an attribute constraint:
1. Select the object with the attribute constraint you want to remove.
2. Open the Display menu.
3. Select Attributes...
The attributes dialog box is displayed.
4. Uncheck the appropriate Constraint check box.
5. Tap on OK.
The attributes dialog box closes and the attribute constraint is
removed.

Point Trails
You can choose to draw the path of a point as the point moves. The path
is known as a point trail. You can create a point trail by manually moving
a point, or by activating an animation.
1. Select the point.
2. Open the Display menu.
3. Select Point Trail.
Anything you subsequently do to the construction that moves the
point will leave a trail of that point.
When you stop moving the point, the point trail is converted to a
sketch. You can select a point trail sketch just as you can a
geometric object. (You could, for example, copy the sketch to
Graph Xpander and apply a fit model to it.)
The following examples illustrate some of the many constructions you
can create using point trails.

Example 1: Parabola. To create a point that traces a parabola:
1. Create a segment AB and constrain its angle of inclination to 0.
See “Viewing and Changing an Object’s Attributes” on page 105 for
instructions on constraining attributes.
2. Select point A and constrain its x coordinate to –10 and its y
coordinate to 0.
3. Create a point C and constrain its x coordinate to 0 and its y
coordinate to 4.
Point Trails
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4. Create a point D and constrain it to segment AB.
See “Creating a point on an object” on page 112 for instructions.
5. Create a segment DE and another segment CE.
6. Constrain segments DE and CE to be congruent.
See “Creating congruent segments” on page 115 for instructions.
7. Constrain segment DE to be perpendicular to segment AB.
See “Creating a perpendicular line” on page 117 for instructions.
Your construction should look similar to that in Figure 6-40.
8. Select point E and choose to display its point trail.
9. Deselect all objects and then select point D.
10. Translate point D.
As point D moves, point E traces the path of a parabola (as in
Figure 6-41).

Figure 6-40: Preparing to
trace a parabola

Figure 6-41: Point trail traces
a parabola

Example 2: Surprising Limacon. To create a point that traces a
limacon:
1. Create two segments: AB and AC.
2. Constrain the coordinates of point A to (0, 0).
3. Constrain the length of AB to 5.
4. Make the angle of inclination of segment AC a dynamic attribute by
making its value twice the angle of inclination of segment AB.
See “Dynamic Attributes” on page 108 for instructions.
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5. Create a segment BC.
6. Create point D and constrain it to be the midpoint of BC.
See “Creating a midpoint on a segment” on page 114 for
instructions.
Your construction should look similar to that in Figure 6-42.
7. Select point D and choose to display its point trail.
8. Deselect all objects and then select point B.
9. Slowly translate point B.
As point B moves, point D traces the path of a limacon (as in
Figure 6-43).

Figure 6-42: Preparing to
trace a limacon

Figure 6-43: Point trail traces
a limacon

Example 3: Solar System. To create a point that traces the path of a
satellite orbiting a planet that is revolving around a star:
1. Make sure that the angle unit setting is radians.
2. Create a point A and constrain its coordinates to (0,0).
3. Create point B.
4. Make the x coordinate of point B a dynamic attribute by making its
value equal to 5·cos(t/40).
5. Similarly make the y coordinate of point B equal to 5·sin(t/40).
6. Create point C.
7. Make the x coordinate of point C a dynamic attribute by making its
value equal to xB+ 2·cos(t/10).
8. Similarly make the y coordinate of point C equal to yB+ 2·sin(t/10).

Point Trails
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Your construction should look similar to that in Figure 6-44.
9. Select point C and choose to display its point trail.
10. Select Start Timer from the Edit menu.
Point C traces the path of a satellite orbiting a planet—point B—
that is revolving around a star—point A—as in Figure 6-45.

Figure 6-44: Preparing to
trace a solar system

Figure 6-45: Point trail traces
a solar system

Deleting an Object
1. Select the object(s) you want to delete.
2. Open the Edit menu.
3. Select Delete.
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Appendix A

Functions and Ope rators
This appendix lists the mathematical functions and operators that can
be selected from the on-screen keyboards. They are grouped according
to the palette on which they appear. See “Math Keyboard” on page 19 for
a description of each palette.

Numeric palette
Key

EEX

Description

Used to enter numbers in
scientific notation.
Syntax
mantissa EEX exponent
Example
8 EEX 26
is displayed as 8E26
and returns 8E+026
(which is equal to 8 × 10

+, –, /, ×

26

)

Addition, subtraction,
division, and multiplication
operators.
Syntax
value operator value
Example
8 × 26
is displayed as 8·26
and returns 208
Table A-1: Numeric palette operators
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Algebra palette
Key

x2

Description

Square.
Syntax
value x2
Example
1 7 x2
is displayed as 172
and returns 289

x

Square root.
Syntax

x value
Example

x 16
is displayed as
and returns 4
–
x1

16

Reciprocal.
Syntax
–
value x 1

Example
–

5x 1
is displayed as 5-1
and returns 0.2
xy

Power (x raised to y).
Syntax
value x y power
Example
5 xy 6
is displayed as 56
and returns 1.563E+004
Table A-2: Algebra functions and operators
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Key
n

x

Description (Cont.)

Represents the nth root of a
number. Tapping this key
opens a template of the form
n x where n is the index of
the root and x is the number.
The cursor appears in the n
field.
Syntax
n

x index, number

Example
n

x 4 →16

is displayed as 4 16
and returns 2
ex

Natural exponential.
Syntax
ex value
Example
ex 4
is displayed as e4
and returns 54.6

ln

Natural logarithm.
Syntax
ln (value)
Example
ln 4
is displayed as ln(4)
and returns 1.386
Table A-2: Algebra functions and operators
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Key

log

Description (Cont.)

Common logarithm.
Syntax
log(value)
Example
log 1000
is displayed as log(1000)
and returns 3

logr

Logarithm to arbitrary base.
Syntax
logbase (value)
Example
logr 2 → 64
is displayed as log2(64)
and returns 6

|x|

Absolute value.
Syntax
|value|
Example
|x|– 5
is displayed as |–5|
and returns 5
Table A-2: Algebra functions and operators
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Number palette
Key

éxù

Description

Ceiling function. Smallest
integer greater than or equal
to value.
Syntax

value
Example
éx ù 7 . 2
is displayed as 7.2
and returns 8
ëxû

Floor function. Greatest
integer less than or equal to
value.
Syntax

value
Example
ëx û 7 8.6
is displayed as 78.6
and returns 78
div

Integer division. The
quotient when value1 is
divided by value2.
Syntax
value1 div value2
Example
3 5 div 8
is displayed as 35 div 8
and returns 4
Table A-3: Number functions and operators
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Key

mod

Description (Cont.)

Modulo. The remainder
when value1 is divided by
value2.
Syntax
value1 mod value2
Example
3 5 mod 8
is displayed as 35 mod 8
and returns 3

gcd

Greatest common divisor.
Returns the greatest
common divisor of two
integers.
Syntax
gcd(argument1, argument2)
Example
gcd 124 →12
is displayed as
gcd(124,12)
and returns 4

lcm

Least common multiple.
Returns the least common
multiple of two integers.
Syntax
lcm(argument1, argument2)
Example
lcm 124 → 12
is displayed as
lcm(124,12)
and returns 372
Table A-3: Number functions and operators
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Key

rseed

Description (Cont.)

Seed for random number
generator.
The algorithm used in the
rand function uses a seed
number to begin its
sequence. To ensure that
two calculations produce
different random sequences,
use the rseed function to
seed different starting values
before using rand to produce
the numbers.
Syntax
rseed value
Example
rseed 1 2 3 4 5 6 7 8 9
is displayed as
rseed(123456789)
and returns Ok.
Table A-3: Number functions and operators
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Key

rand

Description (Cont.)

Uniformly distributed
random number in [0,1)
The algorithm used in the
rand function uses a seed
number to begin its
sequence. See “rseed” on
page 129 (above) for further
information.
Syntax
rand
Example
rand
is displayed as rand
and returns
0.908
Note that this result
assumes that the last
workbook calculation was
the rseed operation
illustrated in the previous
section.

comb

Number of combinations of n
things taken r at a time, with
r≤n.
Syntax
comb(n,r)
Example
comb 5 → 2
is displayed as comb(5,2)
and returns 10
Table A-3: Number functions and operators
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Key

Description (Cont.)

perm

Number of permutations of n
things taken r at a time, with
r≤n.
Syntax
perm(n,r)
Example
perm 5 → 2
is displayed as perm(5,2)
and returns 20

!

Factorial of a non-negative
integer.
Syntax
value !
Example
5!
is displayed as 5!
and returns 120
Table A-3: Number functions and operators

Trigonometric palette
Key

sin

Description

Sine. Inputs and outputs depend
on the current angle mode.
Syntax
sin(value)
Example

π
2

sin ---

π
is displayed as sin æ -ö
è 2ø
and returns 1
(in radians mode)
Table A-4: Trigonometric functions and operators
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Key

cos

Description

Cosine. Inputs and outputs
depend on the current angle
mode.
Syntax
cos(value)
Example
cos 2 0
is displayed as cos(20)
and returns 0.9397
(in degrees mode)

tan

Tangent. Inputs and outputs
depend on the current angle
mode.
Syntax
tan(value)
Example

π
4

tan ---

π
is displayed as tan æ -ö
è 4ø
and returns 1
(in radians mode)
asin

Arc sine. Inverse trigonometric
sine function.
Output range is from –90° to 90°
or –π/2 to π/2. Inputs and
outputs depend on the current
angle mode.
Syntax
asin(value)
Example
asin 1
is displayed as asin(1)
and returns 1.571
(in radians mode)
Table A-4: Trigonometric functions and operators
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Key

acos

Description

Arc cosine. Inverse
trigonometric cosine function.
Output range is from 0° to 180°
or 0 to π.
Inputs and outputs depend on
the current angle mode.
Syntax
acos(value)
Example
acos 1
is displayed as acos(1)
and returns 0
(in either mode)

atan

Arc tangent. Inverse
trigonometric tangent function.
Output range is from –90° to 90°
or –π/2 to π/2. Inputs and
outputs depend on the current
angle mode.
Syntax
atan(value)
Example
atan 1
is displayed as atan(1)
and returns 45
(in degrees mode)

°

Degrees unit of measure. This
operator can be used to
override the current angle
mode.
Syntax
value°
Example
sin 30°
is displayed as sin(30°)
and returns 0.5
(in either degrees or radians
mode)
Table A-4: Trigonometric functions and operators
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Key

Description

Radians unit of measure. This
operator can be used to
override the current angle
mode.
Syntax

r

valuer
Example
sin 1.5 r
is displayed as sin(1.5r)
and returns 0.9975
(in either degrees or radians
mode)
π

3.14159265358979
Table A-4: Trigonometric functions and operators

Test palette
Key

=

Description

Equals. A logical test for equality.
Returns true or false.
Syntax
value1 = value2
Example
2=8
is displayed as 2 = 8
and returns False

≠

Not equal to.
Syntax
value1 ≠ value2
Example
1≠5
is displayed as 1 ≠ 5
and returns True
Table A-5: Test functions and operators
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Key

<

Description

Less than.
Syntax
value1 < value2
Example
1<0
is displayed as 1 < 0
and returns False

≤

Less than or equal to.
Syntax
value1 ≤ value2
Example
2≤4
is displayed as 2 ≤ 4
and returns True

>

Greater than.
Syntax
value1 > value2
Example
7>6
is displayed as 7>6
and returns True

≥

Greater than or equal to.
Syntax
value1 ≥ value2
Example
1≥2
is displayed as 1 ≥ 2
and returns False
Table A-5: Test functions and operators
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Key

and

Description

Returns true if value1 and value2
are both true, otherwise returns
false.
Syntax
value1 and value2
Example
2 < 3 and 5 ≥ 7
is displayed as
2 < 3 and 5 ≥ 7
and returns False

not

Returns true if value is false,
otherwise returns false.
Syntax
not value
Example
not 8 ≤ 9
is displayed as not 8 ≤ 9
and returns False

or

Returns true if either value1 or
value2 is true or both are true,
otherwise returns false.
Syntax
value1 or value2
Example
4 > 6 or 5 ≠ 7
is displayed as
4 > 6 or 5 ≠ 7
and returns True

true

Logical constant

false

Logical constant
Table A-5: Test functions and operators
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Advanced palette
Key

Σ

Description

Summation.
Tapping on this key opens a
template of the form
finalvalue

å

( expression )

variable = initialvalue

which finds the sum of
expression with respect to
variable from initialvalue to
finalvalue.
Template
finalvalue

å

( expression )

variable = initialvalue

Example

Σ x → 4 → 8 →x + 3
8

is displayed as

å

x=

(x + 3)

4

and returns 45
|

Substitutes a value for a
variable. Tapping this key opens
a template of the form
(expr1)|var1 =expr2 , where expr1
is an expression containing the
variable var1, and expr2 is the
value intended to replace var1 in
expr1.
Template
(expr1 )|var1 =expr2
Example
|5 + 3 – x → x → 2
is displayed as
(5 + 3 – x)|x = 2
and returns 6
Table A-6: Advanced functions and operators
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Key

ò dx

Description

Definite integral.
The numerical integral of an
expression between two
numerical limits.
Tapping this key opens a
template of the form
expr 1

òexpr

2

( expr 3 ) dv

where expr1 and expr2 are
expressions that evaluate to real
numbers, v is a variable, and
expr3 is an expression in the
variable v.
Template
expr1

òexpr ( expr3 ) dv
2

Example

ò 1 → 2 → x x2 + 3 x x → x
is displayed as
2 2
ò1 ( x + 3 ⋅ x ) dx
and returns 6.833
Table A-6: Advanced functions and operators
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Key

d
dx

Description

Derivative.
The symbolic first derivative of
an expression with respect to a
specified variable. Tapping this
key opens a template of the
form

d
( exp r 1 )
d ( var1 )
where var1 is a variable, and
expr1 is an expression
containing var1.
Template

d
( exp r 1 )
d ( var1 )
Example
d/dx x → x × sin 2 × x
is displayed as

d
( x ⋅ sin ( 2 ⋅ x ) )
dx
and returns

x ⋅ 2 ⋅ cos ( 2 ⋅ x ) + sin ( 2 ⋅ x )

Table A-6: Advanced functions and operators
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In d ex
A

C

|x| 126
absolute value 126
acos 133
and 136
angles
congruent 116
creating 94
measuring 106
of inclination 83
animation 109
annotate workbook item 16
appending column 43
arc cosine 133
arc sine 132
arc tangent 133
area
of circle 106
of polygon 106
asin 132
atan 133
attributes 84, 105
changing 105
dynamic 108
viewing 105
axes
displaying 89
hiding 51, 89
redisplaying 51

calculations 23–30
deleting 112
editing 112
in geometry 111
ceiling 127
éxù 127
circle
area 106
attributes 105
circumference 106
creating 97
plotting 60
circumference 106
column
appending 43
clearing 44
deleting 44
inserting 43
removing 44
column width, changing 43
comb 130
comment
workbook 12
congruent
angles 116
segments 115
conic sections
plotting 61
constants 22
constraint 105
angles 116
intersection 113
midpoint 114
perpendicular 117
removing 118
segments 115
tangent 118
construction pane 88

B
boundary values
geometry window 89
graph window 69
button groups 54, 93
buttons
geometry window 92
graph window 53
table 41
workbook 9
Index

141

cos 132
cosine functions 56

D
defining a function 36
° 133
degrees 133
deleting
column 44
geometric object 122
graph 85
objects in graph pane 85
row 44
workbook items 12
derivative 56, 81
deselecting 64, 99
dilation
center of 66
geometric objects 102
plots 66
display precision 13
div 127
dynamic attributes 108
deleting 110
editing 110

E
e 22
ex 125
EEX 32
ellipse
plotting 60
entry 5
= 134
equations
in geometry 111
modifying in symbolic pane
65
predefined 55, 60
exiting
Math Xpander 15
workbook 15
142

exponential
general 56
natural 56, 125

F
! 131
factorial 131
false 136
first derivative 56, 81
fit sketch 63
floor 127
ëxû 127
formula pane 88
freehand objects 82, 98
function plots 55
functions
cosine 56
defining 36
exponential 56
linear 56
logarithmic 56
plotting 57
power 56
quadratic 56
sine 56
user-defined 55

G
general exponential 56
geometric constraints 105
geometry 87
accessing 87
buttons 92
menus 91
window 88
graph pane 50
graphing
accessing 48
buttons 53
menus 52
window 49
graphs See plots
Index

> 135
≥ 135
gcd 128
greatest common divisor 128

H
help 6
hyperbola 60

I
inclination 83
input 5
input line 8
inserting
column 43
rows 42
ò 138
integral, definite 138
intersection point 113

K
keyboard
math 19
numeric 20
variables 20

L
lcm 128
least common multiple 128
< 135
≤ 135
line
attributes 105
creating 96
perpendicular 117
linear functions 56
ln 125
log 126
logr 126
logarithm
common 126
natural 125
to arbitrary base 126
Index

logarithmic functions 56

M
math keyboard 19
groups on 20
maximum 46
mean 46
measurement 82
angle 106
angle of inclination 83, 106
area 106
circumference 106
coordinates 83, 106
deleting 83, 107
geometric 106
length 83, 106
perimeter 106
slope 83, 106
median 46
menus 6
geometry 91
graph 52
table 41
workbook 9
message pane 88
midpoint of segment 114
minimum 46
mod 128
modes
degrees 13
radians 13
modulo 128

N
natural exponential 56
not 136
≠ 134
notation, scientific 32
notes 16
n
√x 125
numeric display precision 13
numeric root 37
143

O
object
deleting 85, 122
deselecting 99
freehand 82, 98
selecting 99
online help 6
or 136

P
pane
construction 88
formula 88
graph 50
message 88
statistics 40
symbolic 50
table 50, 73
panning 70, 92
parabola 56, 60
parentheses 31
perimeter of polygon 106
perm 131
perpendicular line 117
π 22, 134
plots
circle 60
cosine 56
dilation 66
ellipse 60
exponential 56
function 55
hyperbola 60
linear 56
logarithmic 56
modifying
parabola 60
power 56
quadratic 56
sine 56
sketching 63
transforming 64
144

translation 65
plotting
by sketching 63
point
analytic 79
attributes 105
constrained to circle 112
creating 79, 94
geometric 79
intersection 113
trace 76
point trail 85, 119
polygon 106
area of 106
creating 97
perimeter of 106
power 124
power functions 56
precedence 31
precision 13
predefined equations
conic sections 60
functions 55
preferences See settings

Q
quadratic functions 56
quartile 46

R
r

134
radians 134
ray
attributes 105
creating 95
reciprocal 124
redisplay
graph 50
table values 50
reflection 104
root 37
rotation 103
Index

row
deleting 44
inserting 42
removing 44

selecting a subexpression 10
Σ 137
summation 137
symbolic pane 50

S

T

sash 41, 49, 88
scientific notation 32
segment
attributes 105
constrained to trace point 81
creating 80, 95
midpoint 114
segments 80
congruent 115
selecting
entry line 10
expressions 10
geometric objects 99
graph 64
result 10
settings 13
angular units 13
geometry 89
graph 68
numeric display precision 13
table 74
sine 131
sine functions 56
sketch
convert to graph 63
geometric objects 82
objects in the graph pane 98
slope 106
special constants 22
√x 124
square root 124
standard deviation 46
statistics 46
calculating 45
pane 40
stylus 5

table
accessing 39
adding data to 42
appending columns 43
buttons 41
changing value in cell 45
clear column 44
editing values 42, 45, 74
inserting columns 43
inserting row 42
menus 41
pane 50, 73
removing column 44
removing row 44
scrolling 73
window 39
zooming 75
table pane 50
tan 132
tangent 118
tick mark spacing 68, 73, 90
timer 108, 109
timer speed 90
trace point 76
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